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Introduccidn

Introduccidén

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacién
creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guia de introduccidn, aprenderd los conceptos basicos del uso de las principales funciones de Harmony
Advanced, y que le permitirdn ponerse al dia rdpidamente. Consulte la documentacién completa de Toon Boom
Harmony disponible en linea en docs.toonboom.com para aprender acerca de todas las herramientas y

opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/
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Capitulo 1: Creacién de una escena

Capitulo 1: Creacion de una escena

Al iniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:
o Crear escenas
« Seleccionar la resolucién de la nueva escena
« Administrar los valores predeterminados de la resolucién de la escena
« Abrir rdpidamente escenas recién abiertas
o Examinary abrir una escena creada
« Ver tutoriales en video de Harmony en la web

« Acceder a la pagina web de soporte

.4 Harmony17 .
n § Advanced

Abrir una escena

Creary reciente

nombrar una
escena

Crear o eliminar
un wvalor
predefinido de
resolucion de
una escena

Seleccionarla
resolucién dela

escena

ch Video Tutorials - Get Help . "
4 : Examinaryabrir
Open...
e -~ una escena
\er tutoriales en Obtener soporte
video de Harmony para Harmony
NOTA

Si estd usando Harmony Server, debe utilizar la aplicacién Control Center para crear escenas
antes de que pueda abrirlas en Harmony. Las escenas de Harmony Server no se pueden crear
directamente en Harmony.
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Creacion de una escena desde la pantalla de bienvenida

1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&A%!.

2. Paradecidir en qué directorio se va a crear la escena, haga clic en el botén Browse (Examinar) junto
al campo Location (Ubicacidn).

4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicacién principal aparecerd con la nueva escena
abierta.
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Capitulo 2: Introduccién a la interfaz de usuario de Harmony

El uso de Toon Boom Harmony serd mucho mas fécil si primero se familiariza con su interfaz de usuario. En este
capitulo se proporciona una introduccién bdsica a los elementos mds importantes de la interfaz de usuario. A
medida que avance de capitulo, obtendrd informacién mas detallada sobre cada uno de estos elementos.

Al iniciar Toon Boom Harmony por primera vez, se presenta el espacio de trabajo predeterminado. El espacio de
trabajo estd compuesto de barras de herramientas y paneles, denominados vistas, que permiten crear y editar
la escena. El espacio de trabajo predeterminado contiene las barras de herramientas y vistas mds utilizadas

para la animacién digital.

Vista de
propiedades de
la herramienta

Barra de
herramientas de
herramientas

Vista de color

Barra de
herramientas de ;
reproduccién *‘Vista de linea
de tiempo

Adicién de una vista al espacio de trabajo como una pestana

1. En laesquina superior derecha de una vista existente, haga clicen el botén 4 Add View (Agregar

vista).

10
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Solid Brush 1
5

Solid Brush 2
10

Solid Brush 3
15

Solid Brush 4
25

Fixed Width 1
1

Fixed Width 2
10

Soft Lead
12 Tool Properties

Timeline

Fine Pencil

2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestafa en la seccién del espacio de trabajo donde la agregé.

11
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@ NOTA

Algunas vistas, como las de cdmara, perspectiva, libreria y modelo, se pueden abrir en varias
instancias. Por ejemplo, puede resultar (til si desea tener dos instancias de las vistas de cdmara
abiertas, cada una centrada en distintas dreas de la escena, para cambiar rdpidamente entre
los trabajos de estas dos dreas.

Adicién de una vista al espacio de trabajo como una ventana

1. Abrael mend Windows (Ventanas).
2. En el mend Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecerda como una nueva ventana sobre la ventana de la aplicacién principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre la vista flotante por la pestafa y realice una de las siguientes acciones:
« Cologue la ventana sobre otra pestafa para agregarla a ese conjunto de pestanas.

« Cologue la ventana por encima, por debajo o junto a una vista existente. Al acercarse al
borde de una vista, aparece un rectdngulo cian que indica dénde se anclard la vista.

12
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Vistas

Aqui se proporciona una breve introduccién a cada una de las vistas mas utilizadas en Harmony.

Vista de cdmara

La vista de cdmara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacién.

La vista de cdmara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en la vista, cambiar el modo de visualizacién o subir la jerarquia de simbolos.

[ Jerarquia de simbolos | [ Barra de herramientas de cdmara |

Mend de vista

Valores
predefinidos de
herramienta Capas de
dibujo

Modo de vista | Modo de vista
de OpenGL | de render

&% W

Mesa de luz | Ment de zoom || Nombre

I Dibujo actual encima] Restablecer vista |_9€! dibujo

Nombre de || Nidmero de Color
herramienta || fotograma seleccionado

| Mdscara de cdmara | ITrazar dibujos bloqueados I

[ Zona segura | | Estilo seleccién BBox |

[ Mostrar guias de alineacién

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cdmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores
descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo
seleccionada actualmente.

13
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Ment de
vista

| Barra de herramientas de vista de dibujo

Drawing | =%

Valores
predefinidos de
h ienta
erramien Capas de
dibujo
Area de dibujo
Nombre del dibujo | | Nombre de herramienta | Nimero de Posicién del | Selector de color I
fotograma cursor

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mds comunes relacionadas con

la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de

herramientas, se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrard las

opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), Apply

to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

Posibles
opciones y
modos parala
herramienta
actual

Posibles
operaciones
para la
herramienta
actual

14
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Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista de
color también es necesaria para dibujar, pintar y crear estilos de color.

| Bajar/subir paletal | Indicador de modo Editar lista de paletas? I

| Vincular paleta I | Mostrar paletas de colores I
| Quitar paleta I | Mostrar paletas de textura de ldpiz I
Mend de vista de colorl Agregar paleta | Mostrar todas las paletas I
| Contraer/expandir lista de paletas
-
Indicador de modo Editar lista
de paletas
= Lista d let
- - ista de paletas
| Indicador de modo Editar paleta?® P
 —
| Agregar muestra de color Modo Editar paleta?
Quitar muestra de color — == | Indicador de modo
| Agregar textura Definir color de Vincular/ Editar paleta?!
I pincel/lépiz/pintura | desvincular
1 tres colores
||
| |
Muestra de color
'-| Lista de muestras de colores
| |
| |
—
| |
| |
 —

El botdn Edit Palette Mode (Modo Editar paleta) solo esta disponible en Harmony Server. Edit Palette Mode (Modo Editar paleta)
siempre esta habilitado en Harmony Stand Alone.

Vista de linea de tiempo

Para establecer el tiempo de la animacidn, trabajara principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy dtil familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

La vista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas clave,
duracidon de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

15
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| Habilitar/deshabilitar capa |

( Habilitar/deshabilitar modo Solo | (or=r
|Agregar.-’quitarpapelcebolla | lml

|Bloquear.-’desbloquearcapa | |Agregarcapa de dibujo |

| Alternar medo de contorne |

Mostrarjocultar Agregar peg Cursor de linea Exposicion de
iy L Paramet i ibui —
imdgenes en miniatura de tiempo dibujo

Ho=al I SRR

| Expandir/contraer grupe | Coordenadas en el
| Expandir/contraer jerarquia de capas | fotograma actual Zoom_de linea Fotog Laiia ?Iave
de tiempo de funcidn
| Mostrar/ocultar vinculos adicionales Mostrar/ Ndmero de dibujo

en el fotograma
actual

ocultar

| Mestrar/ocultar parametros |
funciones

|Ver modos I

La vista de linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la
escena en su forma mas simple. También puede ver las capas y sus nombres, asf como la exposicién del dibujo. El
nombre del dibujo se muestra al colocar el puntero sobre la exposicién del dibujo.

Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostrandolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo
expuesto mostrado por sunombre en las celdas. Se pretende que funcione como una carta de exposicion de

animacidn tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacidn tradicional y sin papel, mientras que la vista de linea de

tiempo se optimiza para una animacién digital o Cut-out.

16
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Barra de herramientas
de carta de rodaje

| Encabezado de columna

Dibujo actual
Fotograma actual

| Exposicién de dibujo

Panel Panel de
principal funciones

Niumeros de Dibujofelemento Columna Aumentar/reducir Modo de
fotograma actual de funcién exposicidn sobrescribir/insertar

Vista de libreria

La vista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar |la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imagenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una estructura
de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee de la plantilla en
una libreria. La plantilla resultante se estructura como una miniescena que solo contiene los elementos que copid
en ella. Una plantilla no tiene ninguna dependencia sobre la escena en la que se cred originalmente. Por lo
tanto, se puede importar de forma segura en cualquier otra escena.

Ademas, el panel Drawing Substitution (Sustitucidn de dibujo) de la vista de libreria permite cambiar
rapidamente la exposicion del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
Cut-out que suelen contener varios dibujos para elegir.

17
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Lista de
recursos

Vista previa de imagen
enminiatura

| Nombre del dibujo *

| Nombre del elemento/recurso

| Control deslizante de fotograma/dibujo

[ATTWI

L}

| Barra de blsqueda

| Lista de carpetas de libreria b :} Syr

| 1Bl campo del nombre del dibujo solo aparece si se selecciona un elemento de la escena.

Interfaz de navegacion

Toon Boom Harmony permite acercar, alejar, rotar, panear y restablecer vistas para navegar facilmente por la
interfaz.

Los comandos de navegacién de la tabla que se muestra a continuacidén se pueden utilizar en las siguientes
vistas, con algunas excepciones:

o Cdmara

o Dibujo

o Perspectiva

e Lineadetiempo
o Cartaderodaje
« Funcién

o Lateral y superior

« Modelo

Comando Accién Métodos de acceso
View > Zoom In (Ver > Acercar)
Pulse 2

Zoom In (Acercar) Acerca la vista. . 3 . .
Gire la rueda del ratén hacia arriba
(excepto en las vistas de linea de tiempo
y de carta de rodaje)

18
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Comando

Accién

Métodos de acceso

Zoom Out (Alejar)

Aleja la vista.

View > Zoom Out (Ver > Alejar)
Pulse 1

Gire la rueda del ratén hacia abajo
(excepto en las vistas de linea de tiempo
y de carta de rodaje)

Acercar o alejar

Acerca o aleja la vista.

Gire la rueda central del ratén hacia
arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y
la rueda central del ratén mientras
arrastra el ratén hacia arriba o hacia
abajo.

Mantenga pulsada la barra espaciadoray

Panear Mueve la vista horizontal o verticalmente. arrastre en la direccién que desee panear
la vista.
Reset Pan View > Reset Pan (Ver > Restablecer

(Restablecer
paneo)

Restablece el paneo de vista a su posicion
predeterminada.

paneo)

Pulse Mayus + N

Reset View
(Restablecer vista)

Restablece la vista a su posicién
predeterminada.

View > Reset View (Ver > Restablecer
vista)

Pulse Maylis + M

Reset Rotation
(Restablecer
rotacién)

Restablece la rotacidn de vista a su posicién
predeterminada.

View > Reset Rotation (Ver >
Restablecer rotacién)

Pulse Mayus + X

Reset Zoom
(Restablecer zoom)

Restablece el zoom de vista a su posicién
predeterminada.

View > Reset Zoom (Ver > Restablecer
zoom)

Rotate View (Rotar
vista)

Rota la vista alaizquierda o ala derecha.

Mientras mantiene pulsadas las teclas
Ctrl + Alt (Windows/Linux) o Ctrl + &8
(mac0S), haga clic y arrastre el disco de
rotacién para rotarlo a la derecha o ala
izquierda.

19
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Comando

Accién

Métodos de acceso

3D Rotate View
(Rotar vista 3D)

Rota la vista en cualquier direccién. Esta
opcidn solo estd disponible en la vista de
perspectiva.

Mientras mantiene pulsado Ctrl + Mayls
(Windows/Linux) o &6 + maylsculas
(macOS), haga clic y arrastre la escena
para rotarla en cualquier direccién.

Rotate 30 CW
(Rotar 30 der.)

Rota la vista de cdmara 30 grados a la
derecha, como una mesa de animacion.

View > Rotate View CW (Ver > Rotar 30
der.)

Rotar 30 izquierda

Rota la vista de cdmara 30 grados a la
izquierda, como una mesa de animacidn.

View > Rotate View CCW (Ver > Rotar
30izq.)

Vista de espejo

Cambia temporalmente la vista de cdmara o
de dibujo en horizontal, lo que permite very
editar la ilustracién como si se estuviera
reflejando.

View > Mirror View (Ver > Espejo)

En la barra de herramientas de cdmara o
de dibujo, haga clic en el botén Mirror

View (Espejo)
. Multiplica inmediatamente el factor de zoom
Toggle Quick . . .
de la vista por 4. Por ejemplo, si el factor de
Close-up (Alternar . ) ;
zoom de la vista de cdmara se encuentra al Mayuds + Z

primer plano
rapido)

100 %, esto hard que alterne entre 400 % y
100 %.

Toggle Full Screen
(Alternar pantalla
completa)

Pasa por los siguientes modos de
visualizacién:

o Normal Full-Screen (Pantalla
completa normal): la ventana
principal de la aplicacién se convierte
en pantalla completa.

o View Full-Screen (Ver pantalla
completa): la vista seleccionada se
convierte en pantalla completay
todas las demds vistas se contraen.

« Normal: la ventana principal de la
aplicacion se restaura a su tamafo
original y las vistas contraidas se
expanden.

View > Toggle Full Screen (Ver >
Alternar pantalla completa)

Pulse Ctrl + F (Windows/Linux) o &8 + F
(macOS)

20
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CONSEJO

Los atajos de teclado se pueden personalizar. Para cambiar sus atajos de teclado, en el menu
superior, seleccione Edit (Windows/Linux) o Harmony Advanced (macOS) > Keyboard Shortcuts
(Edit (Windows/Linux) o Harmony Advanced (macOS) > Atajos de teclado).

Interfaz tactil

Si estd trabajando con una pantalla tactil, un trackpad o una tableta que admita funcidn tactil, también puede
utilizar los gestos de dos dedos estédndar para el zoom, la rotacién y el paneo en las vistas de cdmara y dibujo.
Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacién del soporte de gestos

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enlaseccién Touch Interface (Interfaz tactil), marque la casilla de verificaciéon Support Gestures
(Soporte de gestos).

4. Haga clicen OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de cdmara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.

Uso de gestos

1. Enlavista de cdmara o de dibujo, presione con dos dedos situados a una distancia corta entre si.
2. Realice una de las siguientes acciones:

o Parapanear la vista, arrastre los dos dedos en cualquier direccién, manteniéndolos a la misma
distancia uno del otro.

21
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o Paraacercar el zoom, arrastre los dos dedos separando uno del otro.

o Paraalejar el zoom, arrastre los dos dedos acercando uno al otro.

o Pararotar, arrastre los dos dedos haciendo una curva para que giren en la misma direccién.
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Capitulo 3: Adicion de capas

Al igual que con la animacién tradicional, Harmony utiliza capas para mantener los elementos, como personajes,
fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendra una capa predeterminada denominada Drawing (Dibujo) en la que

se puede comenzar a dibujar de inmediato.

Capa de dibujo
predeterminada

Las capas se pueden seleccionar y gestionar en la vista de linea de tiempo. Una escena puede tener tantas
capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre

las capas inferiores.

Tipos de capas de dibujo
Harmony admite dos tipos de capas de dibujo, cada una con sus propias ventajas y limitaciones:

« Vector Layers (Capas de vectores): los dibujos de vectores estdn formados por puntos y curvas que
componen los contornos de las formas de la ilustracidn, junto con el color o las texturas de relleno. Por lo
tanto, la ilustracién en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos que

contenga una textura.
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Al dibujar en una capa de vector, cada trazo de dibujo y cada linea de |dpiz es un objeto independiente
que se puede manipular por separado. Puede seleccionar trazos y, a continuacién, moverlos y
transformarlos, incluso si se aplicaron trazos de dibujo sobre ellos. Ademds, debido a que los trazos de
dibujo estan formados por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y los
cambios en la ilustracién.

« Bitmap Layers (Capas de mapa de bits): los dibujos de mapa de bits se componen de una cuadricula de
pixeles, que son puntos pequefios que tienen un solo color sdlido. Las herramientas de dibujo de mapa de
bits permiten colocar trazos de pincel en un Unico lienzo plano y ajustar la ilustracién pixel a pixel si es
necesario.

Al dibujar en una capa de mapa de bits, cada trazo se compone en el lienzo, por lo que continda siendo
un dibujo Unico que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad de
pixeles sin perder calidad de imagen. De forma predeterminada, la ilustracion de mapa de bits tiene una
densidad de pixeles del 100 %, que solo es suficiente para mostrar la ilustracién sin ampliarla o escalarla;
de lo contrario, Harmony debe generar nuevos pixeles en la ilustracidn, lo que puede hacer que se vea
borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de pixeles requerida para la ilustracién de mapa
de bits, en funcidn de si tendrd que ampliarla o escalarla, antes de comenzar a dibujar en una capa de
mapa de bits.

NOTA

Como las capas de vectores se pueden editar y escalar, se recomienda comenzar utilizando capas
de vectores mientras se familiariza con Harmony. La capa de dibujo predeterminada de una nueva
escena es una capa de vectores.

Capas de dibujo

De forma predeterminada, cada capa de un dibujo tiene dos capas de dibujo: la capa de lineas y la capa de color.
Puede utilizar estas capas para mantener separadas la capa de lineas y los colores de los dibujos.
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Capa de lineas Capa de color

A la derecha de la vista de cdmara y de dibujo, puede controlar en qué capa de dibujo estd trabajando y si solo
se muestran la capa de dibujo actual o ambas capas de dibujo.

Camera  Drawing (%

Vista previa de todas las capas de dibujo I

Establecer la capa delineas como capa actual |

Establecer la capa de color como capa actual I

De forma predeterminada, estd seleccionada la capa de linea. Por lo tanto, si comienza a dibujar de inmediato,
dibujard en la capa de linea de la capa de dibujo, a menos que seleccione primero la capa de color.

El uso de distintas capas de dibujo para la capa de lineas y la capa de color es completamente opcional. Si lo
desea, puede utilizar la capa de lineas tanto para la capa de lineas como para la capa de color.

NOTA

También puede habilitar capas de dibujo adicionales: las capas superior y de fondo. La capa de
dibujo superior se suele utilizar para anotaciones y la capa de fondo se suele utilizar para esbozos
bdsicos. Para habilitarlas, compruebe la opcién Support Overlay and Underlay Arts (Admitir capas
superior y de fondo) de la pestafia Advanced (Avanzado) del cuadro de didlogo Preferences
(Preferencias), al que se puede acceder seleccionando Edit (Windows/Linux) o Harmony
Advanced (macOS) > Preferences (Edit (Windows/Linux) o Harmony Advanced (macOS) >
Preferencias) en el menu superior.
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Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En
la animacidn tradicional, es comin nombrar a las capas de animacién con letras individuales (A, B, C, etc.) y las
capas de disefio con acrénimos (BG para fondo, OL para superposicion, etc.). Asi, puede comenzar la escena
dando a la primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

noO=am
o

2. Escriba el nuevo nombre de la capa y pulse Intro/retorno.

La capa tiene un nuevo nombre.

Adicién de capas

Adicién de un elemento de dibujo desde la vista de linea de tiempo

1. Realice una de las siguientes acciones:

o Enlavista de linea de tiempo, haga clicen el botén %% Add Drawing Layer (Agregar capa de
dibujo).

« En el menu superior, seleccione Insert > Drawing (Insertar > Dibujo).
o Pulse Ctrl + R (Windows/Linux) o 38 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).
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2. Enelcampo Name (Nombre), escriba el nombre de la nueva capa.

2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).

3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).
4. Realice una de las siguientes acciones:

« Haga clicen Add (Agregar) para crear esta capa, pero deje abierto el cuadro de didlogo para
poder crear mas capas.

« Hagaclicen Add and Close (Agregar y cerrar) para crear esta capay cerrar el cuadro de
didlogo.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

Eliminacion de capas

Eliminacién de capas en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione las capas que desea eliminar.
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NOTA

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayds, haciendo
clicen la primera capa que desee seleccionar y, a continuacién, en la dltima. También
puede seleccionar varias capas manteniendo pulsada la tecla Ctrl (Windows/Linux) o ¢§
(macOS) y haciendo clic en cada capa que desee seleccionar.

2. Realice una de las siguientes acciones:

o Enlabarrade herramientas de capa de la vista de linea de tiempo, haga clicen el botén =
Delete Layers (Eliminar capas).

rnosam

« Haga clic con el botdn derecho en la seleccidn y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de linea de tiempo.

Cambio de orden de capas

Reorganizacién de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione las capas que desea mover.

2. Hagaclicy arrastre la seleccidn, y realice una de las siguientes acciones:

« Cologue la seleccién entre dos capas para moverla entre ellas. Aparecerd una linea cian entre
las capas donde se moverd la seleccidn.

rno=am
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o Cologue la seleccién en una capa para aplicar un rig de las capas seleccionadas como hijas
sobre esa capa.

Agrupacion de capas
La agrupacidon de capas permite mantener la estructura de la escena organizada.

Ademads, puede colocar varias capas dentro de un grupo vy, a continuacién, agregar un efecto en este grupo para
aplicarlo en todas las capas del mismo.

Agrupacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione los elementos que desee agrupar.

NOTA

Las capas que se encuentren entre las seleccionadas se agrupardn con las capas
seleccionadas.

2. Realice una de las siguientes acciones:

« Haga clic con el botdn derecho en las capas resaltadas y seleccione Group Selection
(Agrupar seleccidn).

o Pulse Ctrl + Mayus + G (Windows/Linux) o &8 + mayusculas + G (macQOS).

Se agrega una nueva capa de grupo a la vista de linea de tiempo.
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Si hace clicen el botén Expand Group (Expandir grupo), encontrard las capas agrupadas en rig
como hijos de la capa de grupo.

Ocultar y visualizar capas

Puede ocultar capas temporalmente para que no desordenen la vista de cdmara mientras trabaja en otras
capas.

Ocultar una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, a la izquierda de la capa que desea ocultar, haga clicen el botén (ee
Disable Layer (Deshabilitar capa).

La capa se volverd invisible en la vista de cdmara.

2. Sidesea mostrar la capa, haga clicen el botén “ Enable Layer (Activar capa) para volver a
mostrarla.

Bloqueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas bloqueadas se pueden editar en la vista de lihea de tiempo o
de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de cdmara. Esto puede ser
Gtil para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o personajes con
los que no esté trabajando actualmente.
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Bloqueo de una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, a la izquierda de la capa que desea bloquear, haga clicen el botdn ﬁ
Lock (Blogquear).

rno=am

Serd imposible seleccionar la capa o dibujar en ella en la vista de cdmara. El nombre de la capa
aparecera en rojo en la vista de linea de tiempo.

2. Sidesea desbloguear la capa, haga clicen el botén Unlock Layer (Desbloquear capa) para volver
a mostrarla.
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Capitulo 4: Cémo dibujar

Cuando crea una escena, la escena incluye una capa de dibujo predeterminada en la que puede comenzar a
dibujar de inmediato.

NOTA

Segun su estilo de dibujo y con lo que se sienta cémodo, es posible que prefiera trabajar con la
herramienta Brush (Pincel) o la herramienta Pencil (Lapiz). Para obtener mas informacién sobre la
diferencia entre estas dos herramientas, consulte Cuando crea una escena, la escena incluye una

capa de dibujo predeterminada en la gue puede comenzar a dibujar de inmediato. en la pagina 34.

Dibujo con la herramienta Brush (Pincel)

1. Enlavista de linea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de dibujo.

2. Sidesea dibujar con la herramienta Brush (Pincel), realice una de las siguientes acciones:
« Enlabarra de herramientas de herramientas, seleccione la herramienta &~ Brush (Pincel).
« En el menu superior, seleccione Tools > Brush (Herramientas > Pincel).
o Pulse Alt + B.

Si desea dibujar con la herramienta Pencil (Ldpiz), realice una de las siguientes acciones:

« Enlabarra de herramientas de herramientas, seleccione la herramienta # Pencil (L4piz).
« En el menu superior, seleccione Tools > Pencil (Herramientas > Lapiz).
o Pulse Alt +/.

3. Enlalista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione un
pincel o ldpiz predefinido que desee utilizar.

4. Utilice el control deslizante Maximum Size (Tamafio maximo) para seleccionar el tamafio deseado
para el pincel o Idpiz.
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5. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mas informacidn sobre la creacion y edicidn de colores, consulte Creacion o edicidn de muestras de
colores en la pdgina 48.

Scene Palettes

7. Sidesea realizar cambios en su pincel o Idpiz, en la vista propiedades de la herramienta, haga clicen
el botdn de flecha para abrir el cuadro de didlogo Brush Properties (Propiedades del pincel) o Pencil
Properties (Propiedades del Idpiz). En el cuadro de didlogo Brush Properties (Propiedades del
pincel), puede personalizar el tamafio, la forma, la textura, la difuminacién y los finales de linea del
pincel. En el cuadro de didlogo Pencil Properties (Propiedades del |dpiz), puede personalizar el
tamanio, la difuminacién, la textura y los finales de linea del lapiz.

. /\/ n
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CONSEJOS

Si mantiene pulsada la tecla Mayus antes de dibujar o mientras lo estd haciendo, su trazo
serd recto y tendrd una disposicion vertical u horizontal hasta que deje de dibujar o hasta
que suelte la tecla Mayus.

Si mantiene pulsadas las teclas Mayus y Alt antes de dibujar o mientras lo estd haciendo,
empezard a dibujar una linea recta hasta que deje de dibujar, hasta que suelte las teclas
Mayuls y Alt o hasta que empiece a dibujar en la direccién opuesta.

Si dibuja una linea recta con las teclas Mayus y Alt, y, a continuacién, empieza a dibujar en la
direccién opuesta, el angulo de la linea se bloqueara. Si utiliza una tableta sensible a la
presién, podra volver a dibujar sobre la linea para ajustar su grosor.

Si mantiene pulsada la tecla Ctrl (Windows/Linux) o &8 (macOS) mientras esta dibujando, su
trazo adoptard una forma cerrada.

Si mantiene pulsada la tecla Alt antes de empezar a dibujar un trazoy lo dibuja cerca de
otro trazo, el inicio su trazo se conectara con el otro trazo. Asimismo, si mantiene pulsada la
tecla Alt y termina su trazo cerca de otro trazo, el final de su trazo se conectard con dicho
trazo. Esta opcidn solo funciona con dibujos de vectores.

Ajuste de ilustracion

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el dltimo trazo, borrar partes de un

dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

NOTA

No puede manipular o modificar los trazos del dibujo al dibujar en una capa de mapa de bits;

consulte Adicidén de capas en la pdgina 24.

Deshacer el ultimo trazo

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione Edit > Undo (Editar > Deshacer).

o Pulse Ctrl + Z (Windows/Linux) o0 & + Z (macOS).

Cémo borrar

1. En la barra de herramientas de herramientas, seleccione la herramienta & Eraser (Borrador) o
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pulse Alt + E.

2. Enlavista de dibujo o de camara, dibuje un trazo de borrador sobre las partes del dibujo que desee
borrar.

Manipulacién de los trazos del dibujo

1. Enlabarra de herramientas de herramientas, seleccione la herramienta ® Select (Seleccionar) o
pulse Alt + S.

2. En lavista de cdmara o de dibujo, seleccione los trazos que desee editar realizando una de las

siguientes acciones:
o Haga clicen un trazo para seleccionarlo.

« Mantenga pulsada la tecla Mayus mientras hace clic en un trazo para agregarlo a la
seleccion.

« Dibuje un lazo alrededor de los trazos de dibujo para seleccionarlas simultdéneamente.

3. Realice una de las siguientes acciones para editar la seleccidn:

o Paracambiar lailustracién seleccionada de posicidn, haga clic en ella y arrdstrela a la posicién
deseada.

NOTA

También puede realizar un desplazamiento pequefio de la seleccién con las teclas
de flechay, para realizar un desplazamiento rapido, mantenga pulsado Mayds y
pulse las teclas de flecha.

« Pararotar lailustracidn seleccionada, haga clic fuera de la imagen y coja uno de los
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controladores en las esquinas del cuadro de control y rétela.

o Paraescalar lailustracién seleccionada, haga clicy arrastre uno de los puntos de control en las
esquinas o en el centro de los bordes del cuadro de control.

(- CONSEJO

4 \

Mientras escala la ilustracion, puede conservar las proporciones manteniendo
pulsada la tecla Mayus.

« Parasesgar, arrastre hacia los lados o hacia arriba y abajo de los lados o los segmentos
superior e inferior, entre los puntos de control.
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o Paraeliminar, pulse Supr (Windows/Linux) o retroceso (macQS).

Edicidn de las lineas

1. Realice una de las siguientes acciones:

« Sidibujé con la herramienta Brush (Pincel), en la barra de herramientas de herramientas,
haga doble clicen % Contour Editor (Editor de contorno) y seleccione 2 Centerline Editor
(Editor de linea central) en el menl emergente, o pulse Alt + W.

« Sihadibujado con la herramienta Pencil (Lapiz), en la barra de herramientas de
herramientas, seleccione la herramienta % Contour Editor (Editor de contorno) o pulse Alt +

Q.

2. Enlavista de dibujo o de cdmara, haga clic en la forma, el contorno o la linea de lapiz que desee
editar cerca del drea que desee modificar.

Aparecen los puntos de control de la forma o de la linea.

/

3. Hagaclicen uno de los puntos para seleccionarlo.

Aparecen los controladores de curva Bézier del punto, asi como los controladores de curva Bézier
para los puntos circundantes.
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CONSEJO

Puede seleccionar varios puntos dibujando un lazo alrededor de los mismos, o
manteniendo pulsado Mayds mientras hace clic en los puntos para agregarlos a la
seleccién. Puede utilizar Contour Editor (Editor de contorno) para escalar y rotar una
seleccién de varios puntos habilitando la opcién i+ Show Contour Editor Control
(Mostrar control de editor de contorno) en la vista de propiedades de la herramienta.

4. Realice una de las siguientes acciones:

« Para mover un punto o una seleccién de varios puntos, haga clicy arrastrelo.

o Para cambiar la curva en ambos lados de un punto, arrastre uno de sus controladores de
curva Bézier.

o Para cambiar la curva en un solo lado de un punto, mantenga pulsada la tecla Alt y, a
continuacidn, arrastre uno de sus controladores de curva Bézier.
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/

« Para deformar la curva entre dos puntos, mantenga pulsada la tecla MayUs y arrastre el
contorno entre dos puntos.

o Paraeliminar los controladores de curva Bézier de un punto y hacer que las lineas a las que
estd conectado sean rectas, mantenga pulsada la tecla Alt y haga clic en el punto.

VA
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« Laslineasrectas no tienen controladores de curva Bézier en sus puntos de forma
predeterminada. Para crear controladores de curva Bézier para estos puntosy hacer que sus
lineas sean curvas, mantenga pulsada la tecla Alt y, a continuacién, haga clicy mantenga
pulsado el puntoy arrastre el cursor del ratén lejos de él. Un nuevo controlador de curva
Bézier seguird el cursor del ratén hasta que suelte el botdn del ratén.

« Paraagregar un punto de control, pulse Ctrl (Windows/Linux) o & (macOS) y haga clicen el
contorno donde desea que se cree el nuevo punto.

o Paraeliminar un punto de control, seleccione el punto de control y pulse Supr
(Windows/Linux) o retroceso (macQOS).

Acerca de estilos artisticos, herramientas de dibujo y tipos de capas

Las dos herramientas de dibujo en Harmony son la herramienta & Brush (Pincel) y la herramienta # Pencil

(Lépiz). Segun el estilo de dibujo que desee incorporar, es posible que prefiera trabajar con capas de vectores o
de mapas de bits.
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En las capas de vectores, es posible dibujar con lineas de lapiz, pinceles de vectores y pinceles de mapa de bits
con textura. Mientras que las lineas de lapiz son meramente lineas centrales de vectores a las que Harmony
agrega el grosor, los trazos de pincel son formas de vector sdlidas rellenas con un color, y los trazos de pincel
con textura son regularesy estdn rellenos de una textura de mapa de bits que filtra su color.

Linea de lapiz

Trazo de pincel de vectores

e

Trazo de pincel con textura

En las capas de mapa de bits, solo puede dibujar utilizando pinceles de mapa de bits sdlidos o con textura. Por lo
tanto, aunque las capas de vectores son mas flexibles porque permiten manipular y ajustar facilmente partes de
la ilustracidn, también pueden albergar mds estilos artisticos.

Sin embargo, si utiliza un pincel con textura en una capa de vectores, los trazos de pincel tendrdn una textura
de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa de bits, intentar ajustar o
cambiar el tamafio de un trazo de pincel con textura requerird que Harmony vuelva a probar la textura, lo que
puede hacer que pierda calidad de imagen, a menos que su resolucidén de textura se hubiera aumentado lo
suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los
dibujos de mapa de bits siempre estdan hechos de un solo lienzo plano, los trazos de pincel de vectores se
guardan como objetos independientes. Esto significa que colocar muchos trazos de pincel con textura en un
dibujo de vectores requerird que Harmony almacene la textura para cada uno de estos trazos y los componga
en tiempo real para mostrar el dibujo. Esto puede hacer que los dibujos de vectores cargados de textura, a
diferencia de los dibujos de mapa de bits, hagan que el rendimiento de la aplicacidon sea més lento y el tamaino
del archivo sea mayor. Sin embargo, este es el Unico caso en el que es probable que un dibujo de vectores sea
mas pesado que un dibujo de mapa de bits.
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NOTA

Incluso si aplana la ilustracién, los trazos de pincel con textura de distintos colores no se pueden

aplanar a la vez en las capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Harmony:

Herramienta de Tipo de . .
L Especificaciones
dibujo capa
Ventajas: muy ligero y facil de ajustar. Se puede manipular, volver a colorear y
ajustar mediante la linea central. Se puede acercar o aumentar de tamafo sin perder
calidad.
Lapiz Vector . . L .
Desventajas: no admite texturas. No estd optimizado para transparencia.
Uso recomendado: bocetos, dibujos limpios con un estilo de contorno sélido y
uniforme.
Ventajas: tamafio de archivo ligero. Reproduce el estilo de animacidn tradicional.
Se puede manipular, volver a colorear y editar mediante el contorno o la linea
Pincel de Vect central. Se puede acercar o aumentar de tamafo sin perder calidad.
- ector
vectores sdlido . . .
Desventajas: no puede reproducir el aspecto de los medios naturales.
Uso recomendado: bocetos, dibujos limpios de animacién tradicional.
Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta con las
mismas capacidades que los pinceles de mapa de bits con textura, pero se puede
manipular, editar y volver a colorear como un pincel de vectores sélido.
Pincel d Desventajas: los trazos superpuestos de pincel pueden provocar que el dibujo
incel de . Ly, ~ .
haga que el rendimiento de la aplicacidn sea lento y el tamano de los archivos sea
vectores con Vector . - .
text pesado. Los trazos de pincel de distintos colores no se pueden aplanar a la vez. Si
extura . . . ., . .
se ajusta, aumenta de tamano o acerca la ilustracién, puede disminuir la calidad de
la textura.
Uso recomendado: para ilustraciones con textura de estilo de mapa de bits ligera o
ilustraciones de estilo mixto.
Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor
rendimiento y tamafio de archivo mds ligero que las ilustraciones de vectores
. cargados de textura. Se puede editar pixel a pixel.
Pincel de mapa
. Mapa . . .
de bits con de bit Desventajas: los trazos pincel siempre se aplanan a la vez y no se pueden
€ DIts . L . ~
textura modificar por separado. Solo se pueden dibujar o borrar. Si se aumenta de tamano

o se acerca lailustracién, puede disminuir la calidad de la imagen.

Uso recomendado: ilustracién de mapa de bits cargada de textura.
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Capitulo 5: Cémo pintar

Toon Boom Harmony Incluye algunas funciones de pintura muy Utiles para agregar color a los dibujos. Mientras
que otro software solo permite que los usuarios trabajen con muestras de color de una en una, la pintura en
Harmony se realiza con paletas que contienen varias muestras de color que se pueden almacenar y reutilizar
segun sea necesario.

00 L1 JEEACT | i

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y
modificarlas.

INOOAO00NN
HORR0OgID

Cuando modifique el color de una muestra existente, se actualizardn automaticamente todas las zonas pintadas
con esta muestra en toda la escena. La muestra de color tiene un nimero de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualguier momento sin necesidad de
volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademds de la paleta habitual para un personaje, también puede tener una para ese personaje en la
lluvia con colores mds apagados y menos vivos que los colores de dfas secos, o incluso otra para una escena de
noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacidn se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccidn. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada drea que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este Ultimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
« Cada personaje conserva permanentemente sus colores especificos.
« No puede usar por error un color que no esté en la paleta maestra.
« Estandarizacién y uniformidad del color durante la produccidn.
« Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite un
control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creard una nueva paletay
agregara un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el pelo, la
lengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. En el menude vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clicen el botén
New Palette (Nueva paleta).

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta segtin el modelo.

Ne ette Name: 1

Palette Type:

Cancel

3. Hagaclicen OK (Aceptar).

La paleta aparece en la lista de paletas.
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Colour =%

Eallhdl

Creacidn o edicidon de muestras de colores

1. Sidesea crear una nueva muestra de color, haga clicen el botén <+ Add Colour (Agregar color) en la
vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de color.

2. Realice una de las siguientes acciones para editar la muestra de color:
« En el menu de vista de color, seleccione Colours > Edit (Colores > Editar).
o Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

Multi Wheel Mode

3. Paradefinir el color, realice una de las siguientes acciones:

« Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation (Saturacién)
o Value (Valor) para cambiar el espectro del circulo cromatico y, a continuacién, haga
clic en el color que desee en el circulo cromatico.

« Introduzca los valores de matiz, saturacion, valor, rojo, verde y azul de forma manual en
los campos correspondientes. Todos los valores oscilan entre O y 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él dreas de un dibujo,
todas las dreas pintadas con este color en los dibujos vectoriales se actualizardn al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cémo pintar dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse Alt
+ 1.

3. Enlavista de color, seleccione una paleta del personaje.

4. Seleccione un color de la paleta.

E‘ Colour == [%

W Palettes

Scene Palettes

[Adlw ]
‘Wm0 s B *

5. En lavista de dibujo o de cdmara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas dreas del dibujo no estaban completamente cerradas debido a
pequefios huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el drea, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible, que
la herramienta Paint (Pintar) considerara como una linea normal. En Harmony, las Iineas invisibles utilizadas
para definir las dreas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequenos huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente para rellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisién. Solo tiene que dibujar un trazo basico junto al hueco para que se cree automaticamente una linea
vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

1. Antesde trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar |lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo o
de cdmara. Puede habilitar la opcién Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

« En el menu superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

e Pulse K
2. Realice una de las siguientes acciones:

o Enlabarra de herramientas de herramientas, seleccione la herramienta (7 Close Gap
(Cerrar hueco).

« En el menu superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

e Pulse Alt + C.
3. Enlavista de cdmara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opcién Close Gap (Cerrar hueco), que se
puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada, Harmony
automaticamente intentard encontrar y cerrar pequefios huecos cuando intente rellenar una
forma que no esté cerrada.
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Capitulo 6: Creacion de una animacion tradicional sin papel

Creacidn de un boceto de animacidn

El primer paso para crear una animacion sin papel es la creacidn de un boceto, que es el esqueleto de la
animacién. Por lo general, empezarfa animando la parte mds importante de la accién de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacién secundaria como la cabeza, los brazos y la ropa.

Para que la animacién sea satisfactoria, comience animando la accién principal con esbozos bdésicos y rdpidos y,
a continuacion, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos los
detalles inmediatamente, perderd mucho tiempo en caso de tener que realizar correcciones, y es probable que

la animacidn tenga una apariencia rigida.

Creacién de un boceto de animacion

1. En lafila superior de la vista de linea de tiempo, haga clicen Show All Thumbnails (Mostrar todas
las imdgenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

2. Pulse Ctrl + U (Windows/Linux) o & + U (macOS) para abrir el cuadro de didlogo Preferences
(Preferencias).

3. Seleccione la pestafia Exposure Sheet (Carta de exposicidn).

4. Seleccione la opcidn Use Current Frame as Drawing Name (Usar fotograma actual como nombre de
dibujo). Cuando esta preferencia esté habilitada, los dibujos nuevos se nombraran con el nimero de
fotograma en el que se crearon.
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5. En la barra de herramientas de herramientas, seleccione la herramienta »” Brush (Pincel) o pulse
Alt + B.

6. En lavista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el
boceto de animacidn. Esto facilitara el proceso de clean up, ya que las lineas oscuras y limpias haran
contraste con las lineas esbozadas claras.

7. Enlavista delinea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el primer dibujo.

8. Enlavista de cdmara o de dibujo, dibuje el primer dibujo clave.

9. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imdgenes en miniatura
dentro de las celdas realizando una de las siguientes acciones:

o Arrastre el control deslizante _Timeline Zoom (Zoom de linea de tiempo) hacia
la derecha.

« Hagadlicen la pestafia de la vista de linea de tiempo y pulse 2 de forma reiterada.
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o Mueva el cursor del ratdn en la vista de linea de tiempo, mantenga pulsado Ctrl
(Windows/Linux) o & (macOS) y gire la rueda del ratén hacia arriba.

MroSalM

10. Con la primera celda atn seleccionada, realice una de las siguientes acciones para marcar el dibujo
como dibujo clave. Esto le ayudard a mantener el orden.

» Habilite la barra de herramientas Mark Drawing (Marcar dibujo) seleccionando
Windows > Toolbar > Mark Drawing (Ventanas > Barra de herramientas > Marcar
dibujo) en el menu superior v, a continuacién, haga clic en el botén © Mark Selected
Drawings as Key (Marcar como dibujo clave).

« Habilite la barra de herramientas de carta de rodaje centrdndose en la carta de rodaje
y seleccione Windows > Toolbar > Xsheet (Ventanas > Barra de herramientas > Carta
de rodaje) en el menu superior. A continuacidn, haga clic en el botén © Mark as Key
Drawing (Marcar como dibujo clave).

o En el mendde lavista de linea de tiempo, seleccione Drawings > Mark Drawing As >

Key Drawing (Dibujos > Marcar dibujo como > Dibujo clave).

11. Enlavista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.

12. Enla barra de herramientas de herramientas, haga clic en el botdn é Onion Skin (Papel cebolla).
Esto mostrard los dibujos anteriores y siguientes en un color claro en la vista de cdmara o de dibujo,
detrds del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos con
precisién. Esta opcidn puede ser (til para dibujar poses de descomposicidn entre dos poses clave, o
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para agregar un dibujo intercalado entre otros dos dibujos.

[ Intervalo de dibujos mostrados en papel cebolla l

13. Asegurese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

« Enlavista de linea de tiempo, haga clicy arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.

« Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Paraaumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botén == Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Paraaumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén ‘? Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clicen
el botén == Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.
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[ Intervalo de dibujos mostrados en papel cebolla I

NOTA

En la vista de dibujo, puede utilizar la barra de herramientas Onion Skin (Papel
cebolla) para que el papel cebolla solo muestre tipos especificos de dibujos, como
dibujos clave o descomposiciones. Tenga en cuenta que esto no funciona en la

vista de cdmara.

14. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clicen el
botdn ¥ Create Empty Drawing (Crear dibujo vacio).

« Pulse Alt + Mayus + R.

15. En lavista de cdmara o de dibujo, dibuje el segundo dibujo clave.
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17. Enlavista de linea de tiempo o de carta de rodaje, seleccione una celda entre los dos dibujos clave.

18. Al usar los marcadores de papel cebolla, asegurese de que el papel cebolla cubra tanto el primer

como el dltimo dibujo.

[ Intervalo de dibujos mostrados en papel cebolla l

19. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clicen el
botén ¥<| Create Empty Drawing (Crear dibujo vacio).

« Pulse Alt + Mayus + R.

20. En lavista de cdmara o de dibujo, dibuje la nueva pose.

21. Enlavista de linea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos

anteriores para cada nuevo dibujo.

NOTA
<

Al trabajar con capas de superposicién en la vista de cdmara, puede habilitar la opcién £
Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de
cdmara para hacer que la capa en la que estd trabajando aparezca sobre las otras capas.
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Revision de la animacién

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se estd trabajando conectan bien
entre si'y crean lailusién de movimiento adecuada. Puede desplazarse rdpidamente por los dibujos con los
atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente, o con la barra de herramientas Easy Flipping
(Flipping sencillo).

Desplazamiento por los dibujos

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee
desplazarse.

2. Realice una de las siguientes acciones:
o Pulse F parair al dibujo anterior.
o Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atrds o
hacia delante.

Uso de la barra de herramientas Easy Flipping (Flipping sencillo)

1. Cambie ala vista de dibujo.

2. En el mend superior, seleccione Windows > Toolbars > Easy Flipping (Ventanas > Barras de
herramientas > Flipping sencillo) para habilitar la barra de herramientas de flipping sencillo.

3. Enlabarra de herramientas de flipping sencillo, haga clicen el botén <1 Previous (Anterior) o I1»
Next (Siguiente) para ver el dibujo anterior o siguiente de la animacidn.

4. Para mostrar los dibujos del primer fotograma después de llegar al dltimo fotograma de la animacion,
seleccione la opcién Loop (Bucle).

|
| &
& 3R

5. Mueva el control deslizante hacia la derecha para desplazarse hacia delante y hacia la izquierda
para desplazarse hacia atrds por los dibujos.
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Cuanto mas mueva el control deslizante hacia la izquierda o la derecha, mds deprisa se desplazaran
los dibujos.

6. En el campo Preroll (Preprocesamiento), introduzca la cantidad de dibujos por los que desplazarse
automaticamente antes y después del dibujo actual.

7. En el campo FPS, introduzca la velocidad a la que desee desplazarse automaticamente por los
dibujos en fotogramas por segundo.

8. Hagaclicen el botén » Easy Flip (Flip sencillo) para desplazarse automdaticamente por los dibujos

en funcidn de la configuracién de Preroll (Preprocesamiento) y FPS.

Cuando el boceto de animacidn esté terminado, reproduizcalo para asegurarse de que es lo que se esperaba
antes de continuar con el siguiente paso.

Reproduccién de la animacion

1. En lavista de Iinea de tiempo, haga clic en el botén del modo @ Solo a la izquierda de cada capa
que desee ver durante la reproduccidn en la vista de linea de tiempo para habilitar el modo @ Solo
en estas capas.

roSalM

Cuando una o mds capas tengan habilitado el modo Solo, Unicamente se mostrardn las capas que
tengan este modo habilitado, y las otras capas quedardn ocultas.

2. Enlavista delinea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga clic
en el botdn Start (Iniciar) en la barra de herramientas de linea de tiempo. A continuacién, mueva el
cabezal al dltimo fotograma de la animacién y haga clic en el botén Stop (Detener).

3. Enlabarra de herramientas de reproduccién, haga clicen el botén O Loop (Bucle) para habilitar la
opcidén de bucle durante la reproduccidn.

4. Enlabarra de herramientas de reproduccién, haga clicen el botén » Play (Reproducir) para
comenzar la reproduccién.

Limpieza

Una vez que se haya completado el boceto de animacidn, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
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cerrar las zonas abiertas. Es el paso final de la animacién sin papel antes del paso de ink and paint.

En una animacidn tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el boceto
debajo, que se puede ver con la mesa de luz del disco de animacién. Del mismo modo, en Harmony, tendra que
agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando haya
terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animacién para que no
aparezca en la animacidn final. Este enfoque también permite mantener los bocetos y los dibujos de clean up

intactos y administrarlos de manera independiente.

En la vista de cdmara, vera el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animacién mientras realiza

trazados en la capa de clean up.

Trazado de la animacién en una nueva capa

1. Enlavista de linea de tiempo, cambie el nombre de la capa en la que cred el boceto de animacion
haciendo doble clicen su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

2. Enlavista delinea de tiempo, agregue una capa realizando una de las siguientes acciones:

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
botén % Add Drawing Layer (Agregar capa de dibujo).

o Pulse Ctrl + R (Windows/Linux) o 3£ + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

@ Bitmap

Add and Close Adc Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".
2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).

3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).
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4. Hagaclicen Add and Close (Agregar y cerrar) para agregar una nueva capay cerrar la ventana.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

5. En lavista de linea de tiempo, haga clic en el icono Lock (Bloguear) de la capa que contiene el
boceto de animacién para impedir que dicha capa se pueda seleccionar en la vista de cdmara.

6. Enlavistadelinea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que
corresponda al primer dibujo clave del boceto de animacidn.

7. Enlabarra de herramientas de herramientas, seleccione una herramienta de dibujo, como la
herramienta # Pencil (Lapiz).

8. Enlavista de color, seleccione un color para trazar la animacién. Seleccione un color oscuro intenso,
como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de

animacion.

9. En lavista de cdmara o de dibujo, comience a trazar el primer dibujo clave.
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10.

11.

12.

NOTA

Si las capas de superposicidn estdn en medio, puede deshabilitarlas
temporalmente haciendo clic en su botén (€4 Enable/Disable
(Habilitar/deshabilitar) en la vista de linea de tiempo para que solo se muestren el
boceto de animacién y las capas de clean up.

En la vista de linea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a
un boceto de dibujo.

En la barra de herramientas de herramientas, haga clic en el botén é Enable Onion Skin (Habilitar
papel cebolla) para habilitar el papel cebolla.

Aseglrese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las
siguientes acciones:

o Enlavista de linea de tiempo, haga clicy arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacidn, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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o Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Paraaumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botén == Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Paraaumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clicen
el botén == Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de cadmara/dibujo.

13. En lavista de cdmara, trace el siguiente dibujo.

14. Repita los pasos anteriores para cada dibujo.
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Capitulo 7: Aplicacion de morphing a dibujos

La animacion dibujada a mano requiere que pase mucho tiempo trazando dibujos intercalados. La funcién de
morphing de Harmony puede ayudar a acelerar el proceso. Esta Util funcién crea automaticamente dibujos
generados por ordenador entre los dibujos de vectores para ahorrar tiempo y aumentar la productividad. Puede
modificar facilmente el tiempo vy la velocidad (aceleracidn y desaceleracion gradual) de una animacion de
morphing.

Uno de los principales usos de la funcién de morphing es la animacidn de efectos. Por ejemplo, la animacién de
humo o agua puede llevar mucho tiempo, ya que estos tipos de efectos suelen ser de movimiento lento, lo que
requiere un gran numero de intercalados estrechamente conectados.

La funcidn de morphing se utiliza para animar formas similares y simples, como pelo o humo. De este modo,
podra ahorrar tiempo durante tareas de intercalado y trazado pesadas. A su vez, le proporciona mas tiempo
para emplearlo en tareas complejas de animacidn, como ciclos de andar o secuencias acrobaticas.

Para aprender a aplicar morphing a dibujos, es mejor comenzar con formas bdsicas, como circulos y rectédngulos.
Una vez que esté mas familiarizado con la herramienta, puede aumentar sus conocimientos y experiencia. En
muy poco tiempo, producird algunos efectos notables.

Es dtil conocer los pros vy los contras del morphing antes de comenzar. Si sabe lo que puede hacer y qué lineas
de dibujo pueden ser mas Utiles o problematicas, podra disefiar dibujos clave para aplicar el morphing de forma
eficiente.

NOTA

Cuanto mds compleja es la forma, mds tarda en aplicarse el morphing. Si necesita mas tiempo para
transformar un dibujo que para dibujarlo a mano, es mejor animarlo en lugar de aplicar la técnica de
morphing. Sin embargo, si encuentra una ocasion en la que pueda aplicar morphing a los dibujos,
hdgalo. Permite fijar el tiempo vy la velocidad rdpidamente sin la necesidad de crear dibujos
adicionales.
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Creacion de un elemento de morphing basico

1. Enlabarrade herramientas de linea de tiempo, haga clic en el botén ©. Add Drawing Layer
(Agregar capa de dibujo) para agregar una nueva capa al proyecto.

2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

3. Enlavistadelinea de tiempo o de carta de rodaje, seleccione la primera celda de la capa.

4. Realice una de las siguientes acciones:

« Enlabarrade herramientas de herramientas, seleccione la herramienta [ Rectangle
(Rectangulo).

o Pulse Alt +7.

5. En lavista de cdmara o de dibujo, dibuje un rectangulo.

NOTA

Al dibujar un rectdngulo o una elipsis, puede mantener pulsada la tecla Mayus
para dibujar su forma con las mismas dimensiones, asi como para hacer un
cuadrado o un circulo en su lugar. También puede mantener pulsada la tecla Alt
para dibujar la forma desde su centro y no desde su esquina.

6. Pinte el rectangulo con la herramienta Paint (Pintar).

7. Enlavista de carta de rodaje o de linea de tiempo, seleccione la celda en la que desea que termine la
secuencia de morphing.
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rMo=asHl
“.

8. Realice una de las siguientes acciones:

« Enlabarrade herramientas de herramientas, seleccione la herramienta O Ellipse
(Elipse).

o Pulse Alt + =.

9. Dibujey pinte la elipse con el mismo contorno y colores de relleno que en el rectangulo.

10. En lavista de carta de rodaje o de linea de tiempo, seleccione el rango de fotogramas que va desde
el primer dibujo hasta el segundo dibujo, incluidos los fotogramas que contienen los mismos.

wO=all
{t.

11. Realice una de las siguientes acciones:

« En el mend superior, seleccione Animation > Morphing > Create Morphing (Animacién
> Morphing > Crear morphing).

« En lavista de carta de rodaje o de linea de tiempo, haga clic con el botdn derechoy
seleccione Morphing > Create Morphing (Morphing > Crear Morphing).

o Pulse Alt + M.

Aparecen las flechas que van desde el primer dibujo clave hasta el segundo dibujo clave, que indican
que se han creado los intercalados generados por ordenador.
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Ajuste de la velocidad de morphing
Si observa la animacidén, notard que el movimiento de morphing es constante. Para producir un movimiento

menos mecdnico, es probable que desee crear alguna aceleracién o desaceleracién gradual.

Adicién de aceleracion y desaceleracion gradual a un elemento de morphing

1. Enlabarrade herramientas de herramientas, seleccione la herramienta ?}) Morphing o pulse F3.

2. Enlavista delinea de tiempo, haga clic en un fotograma de la secuencia de morphing que desee

ajustar.

3. Enlavista de propiedades de la herramienta, aumente o reduzca el valor de Ease In (Aceleracidon
gradual) y Ease Out (Desaceleracidn gradual) para ajustar la velocidad de la secuencia.

4 Mmain

ya

Adicién de sugerencias de morphing

La herramienta Morphing de Harmony permite controlar su secuencia de morphing de muchas maneras. Una
de esas maneras es colocar sugerencias para asegurarse de que Harmony transforme los dibujos de la manera
que tenfa prevista.

Las sugerencias son puntos que se colocan en los dibujos de origen y de destino para asociar zonasy lineas
entre los dos dibujos. Se utilizan para corregir errores de las transformaciones de dibujos que realiza Harmony,
como una linea que no sigue la zona de relleno de color o cuando una parte del dibujo de origen no se
transforma en su parte correspondiente del dibujo de destino. De forma predeterminada, Harmony asociara
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una esquina o un punto en el dibujo de origen con la esquina o punto mds cercanos del dibujo de destino. Por lo
tanto, las sugerencias son necesarias si la forma que se va a transformar o su movimiento son complejos.

Adicion de sugerencias

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo de origen de la secuencia de
morphing.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta P}) Morphing o pulse F3.

Utilice como referencia el otro dibujo clave de morphing, mostrado en la esquina inferior derecha de
la vista de dibujo.

o Seleccione Contour Hint (Sugerencia de contorno) para corregir el contorno de una

linea de pincel o de una zona de color (vector de contorno).

Los puntos de Contour Hint (Sugerencia de contorno) se comportaran de manera
similar que los puntos de Pencil Hint (Sugerencia de Idpiz) cuando se utilizan en una
linea de ldpiz. Tenga en cuenta que obtiene mejores resultados utilizando el punto de
Pencil Hint (Sugerencia de 1dpiz) en la linea de Idpiz en lugar de los puntos de Contour
Hint (Sugerencia de contorno).

« Seleccione Pencil Hint (Sugerencia de Idpiz) para corregir una linea de lapiz (vector
central).
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o Seleccione Zone Hint (Sugerencia de zona) para corregir una coincidencia de
morphing de zona de color.

« Seleccione Vanishing Point Hint (Sugerencia de punto de desaparicién) para corregir
la trayectoria de una forma de desaparicidn.

« Seleccione Appearing Point Hint (Sugerencia de punto de aparicidn) para corregir la
trayectoria de una forma de aparicion.

4. En lavista de cdmara o de dibujo, haga clic en el dibujo situado junto al drea problematica.

5. Seleccione el punto de la sugerencia y muévalo a su posicidon correcta.

6. Enlavistadelinea de tiempo o de carta de rodaje, seleccione el dibujo de destino.

7. Busgue y mueva el punto de la sugerencia correspondiente a la parte coincidente del dibujo de
destino.

—(0)
Q)
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8. Enla barra de herramientas de reproduccién, pulse el botén » Play (Reproducir) para ver el
resultado.

70



Gufa deintroduccién de Harmony 17 Advanced

71



Capitulo 8: Importacién de imagenes

Capitulo 8: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imdgenes de vectores creadas dentro de su propia interfaz.
Las imagenes de vectores se componen principalmente de informacién sobre las distintas formas que
componen las imdgenes, asi como de sus colores de linea y de relleno. Esto hace que sean faciles de editar y
pintar, y permite redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imdgenes de
mapa de bits se componen de informacién de color sobre cada pixel individual que compone la imagen. Por lo
tanto, son mas adecuados para imdgenes muy detalladas o realistas, pero no se pueden escalar sin perder
calidad de imagen, ni se pueden editar tan facilmente como las imagenes de vectores.

Normalmente, es necesario trabajar con imdgenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacién, puede importar los archivos de
imdgenes de mapa de bits en su escena de Harmony.

Alimportar una imagen de mapa de bits, debe decidir cémo debe procesarla Harmony. Puede elegir entre las

siguientes opciones:

« Keep as Original Bitmap (Mantener como mapa de bits original) (Importar como mapa de bits): importa
la imagen exactamente tal como estd y garantiza que no se pueda modificar cuando se trabaje en la
escena. Esta opcidn es Util para utilizar fondos creados en el proyecto con un software diferente.

o Import as Toon Boom Bitmap Drawing (Importar como dibujo de mapa de bits de Toon Boom): importa
la imagen tal como estd, pero permite editarla con las herramientas de dibujo de mapa de bits de
Harmony.

o Import as Toon Boom Vector Drawing (Importar como dibujo de vector de Toon Boom) (Vectorizar):
convierte un mapa de bits en un dibujo vectorial de Toon Boom que se puede pintar y editar facilmente
con las herramientas de dibujo vectorial de Harmony. Esta opcidn puede ser Util para la importacion de
capa de lineas escaneadas o creadas con un software diferente.

Importacién de una imagen de mapa de bits en su formato original

1. Realice una de las siguientes acciones:

o En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

o Enlabarrade herramientas de archivo, haga clicen el botén " Import Images
(Importar imagenes).

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
area de fotogramasy seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

2. Enla seccidén Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clicen
Browse (Examinar) para buscar y seleccionar una o mds imdgenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcién Create Layer(s)
(Crear capas) y una de las siguientes opciones:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

« Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tgay b-1.tga, se creardn dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imagenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imdgenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacidn. Por ejemplo, si va a importar imdgenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. En la seccidén Vectorization (Vectorizacidn), asegurese de que la opcién Vectorize Image (Vectorizar
imagen) no esté marcada.

5. En la seccién Import Options (Opciones de importacidn), seleccione la opcién Keep As Original
Bitmap (Mantener como mapa de bits original).

6. Enlaseccién Alignment (Alineacidn), decida el tamafo vy la posicién de la imagen dentro del
encuadre de cdmara. Puede elegir entre las siguientes opciones:
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Pardmetro Descripcién

Ajusta el tamafio de laimagen para que se adapte completamente al campo de la
escena, tanto vertical como horizontalmente, asegurdndose de que toda la
imagen sea visible.

Si la orientacién de la imagen es vertical, ajustard la altura de la imagen para que
se adapte a la altura del campo sin que afecte a la proporcion de la imagen:

Resolucién de

Fotograma de

Fit
. I rtical
(AJ usta r) r:‘galggdnov:!inlec:c.i::nnds

Si la orientacidon de la imagen es horizontal, ajustard el ancho de la imagen para
que se adapte al ancho del campo sin que afecte a la proporcién de la imagen:

Resolucién de

Fotograma de

Imagen horizontal con
regla de alineacién de

Esto tiene el efecto opuesto al pardmetro de ajuste. La dimensién mdas pequefia
de laimagen se ajustard a la dimensidn coincidente del fotograma de la escena,
y la dimensién mds grande de la imagen se ajustard proporcionalmente,
Panear haciendo que la imagen llene todo el campo de la escena y abarque mds alld de
sus Iimites si su proporcidén no coincide con la proporcién del campo. Esta
opcidn se puede utilizar para importar una imagen de fondo de paneo, también
denominada paneo.

74



Guia de introduccién de Harmony 17 Advanced

Si la orientacién de la imagen es vertical, ajustard el ancho de laimagen para que
se adapte al ancho del campo sin que afecte a su proporcidn:

Imagen vertical con
regla de alineacién de
paneo

Resoluciénde
camara

Fotograma de

Si la orientacién de la imagen es horizontal, ajustard la altura de la imagen para
que se adapte a la altura del campo sin que afecte a su proporcidn:

g de R L Imagen hori con regla de alineacién de
de cdmara

Escala laimagen para que se ajuste a la resolucién de la escena, haciendo que

Resolucidn cada pixel de laimagen tome un pixel del campo de la escena. Por ejemplo, si las
de dimensiones de la imagen en pixeles son la mitad de la resolucién de la escena
proyecto en pixeles, las dimensiones de laimagen parecerdn ser la mitad de las

dimensiones del campo de la escena.

7. Enlaseccién Transparency (Transparencia) decida cdmo desea que se suavice la imagen de mapa
de bits, en concreto, la forma en que los pixeles a lo largo del borde se mezclan con los otros

colores. Puede elegir entre las siguientes opciones:

Pardmetro Descripcién

Premultiplied with White Los pixeles individuales del borde de una imagen se mezclan
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(Premultiplicado con blanco) con blanco.
Premultiplied with Black Los pixeles individuales del borde de unaimagen se mezclan
(Premultiplicado con negro) con negro.

Straight (Recto) Los pixeles individuales del borde de una imagen se mezclan
rai ecto
J con negro, blanco y grises.

Premultiplica el valor de color con el valor de alfa. Cuando el
color se fija al alfa, el valor de color no puede ser mayor que el
valor de alfa. Calcula el valor de color real mds rdpido. Cuando
Clamp Colour to Alpha (Fijar los valores de RGB se multiplican con el valor de alfa, por
color a alfa) ejemplo, si tiene un pixel con el valor R=247, G=188, B=29 y
el alfa es del 50 % o la imagen tiene una transparencia del

50 %, los valores de RGB reales que se generan serian la
mitad de las cantidades indicadas.

8. Hagaclicen OK (Aceptar).

NOTA

De forma predeterminada, las imdgenes de mapa de bits se mostraran en baja resolucion en la
vista de cdmara para evitar que afecten al rendimiento de la reproduccidn. También puede
ajustar la calidad de visualizacidon de una imagen de mapa de bits selecciondndola con la
herramienta Transform (Transformar) y, a continuacidn, abriendo el cuadro de didlogo Bitmap
Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa
de bits en la resolucién de la escena activando el modo Render Preview (Vista de render) en
la vista de cadmara.

Vectorizacién de imagenes

Harmony permite importar imagenes como dibujos de vectores. Los dibujos de vectores se pueden pintary
editar facilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser Util parala
importacion de capa de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarla en
Harmony.

Importacién de una imagen de mapa de bits como un dibujo de mapa de bits de Toon
Boom

1. Realice una de las siguientes acciones:
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« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

o Enlabarra de herramientas de archivo, haga clicen el botén ‘iz Import Images
(Importar imdgenes).

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramasy seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imdgenes).

Cancel

1. En la seccién Files (Archivos) del cuadro de didlogo Import Images (Importar imdgenes), haga clicen
Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imagenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

« Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se creardn dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imdgenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
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compatibles con las opciones de importacidn. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

2. Enlaseccidn Alignment (Alineacién), decida el tamafio y la posicién de laimagen dentro del
encuadre de la cdmara. Puede elegir entre las siguientes opciones:

Parametro Descripcién

Ajusta el tamafo de laimagen para que su altura coincida con
la altura de la escena, sin que afecte a su proporcién.

Vertical Fit (Ajuste vertical)

Resclucidn de

Imagen con regla de
alineacién de ajuste Fotograma de
vertical

Ajusta el tamano de la imagen para que su ancho coincida
con el de la escena sin que afecte a su proporcién.

Horizontal Fit (Ajuste
horizontal)

Resolucién de

Imagen con regla de Fotograma de
alineacion de ajuste
horizontal

Importa la imagen a tamafo real sin ajustar su tamano en
proporcidn a la resolucion de la escena. Por ejemplo, si las
. B dimensiones de laimagen en pixeles son la mitad de la
Actual Size (Tamano real) ., ; . .
resolucién de la escena en pixeles, las dimensiones de la
imagen parecerdn ser la mitad de las dimensiones del campo

dela escena.
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3. Enlaseccién Transparency (Transparencia) decida cdmo desea que se suavice la imagen de mapa
de bits, en concreto, la forma en que los pixeles a lo largo del borde se mezclan con los otros
colores. Puede elegir entre las siguientes opciones:

Parametro Descripcién

Premultiplied with White Los pixeles individuales del borde de una imagen se mezclan
(Premultiplicado con blanco) con blanco.

Premultiplied with Black Los pixeles individuales del borde de una imagen se mezclan
(Premultiplicado con negro) con negro.

Straight (Recto) Los pixeles individuales del borde de una imagen se mezclan
rai ecto
9 con negro, blanco vy grises.

4. Hagaclicen OK (Aceptar).

Importacién y vectorizacion de una imagen de mapa de bits

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

o Enlabarra de herramientas de archivo, haga clicen el botén ‘iz Import Images
(Importar imdgenes).

o En lavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Images (Importar > Imdgenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

1. En la seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clicen
Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imdgenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

« Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imdgenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa lasimagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. Enla seccién Import Options (Opciones de importacion), seleccione la opcién Convert to Toon Boom
Vector Drawing (Convertir a dibujo de vector de Toon Boom).

4. En la seccién Vectorization (Vectorizacién), decida si desea importar la imagen en blanco y negro, o
en grises. También puede hacer clic en el botdn New Preset (Nuevo valor predef.) para crear un
pardmetro de vectorizacién personalizado.
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» Black and White (Blanco y negro): vectoriza los dibujos como una linea negra sdlida; crea un
dibujo 100 % basado en vectores. Los contornos de los dibujos se pintaran con la muestra de
color de la linea vectorizada de la paleta de colores de la escena.

» Grey (Gris): vectoriza la imagen como una mezcla de contorno de vectoresy relleno de mapa de
bits en escala de grises. Las lineas conservan la textura de la digitalizacién, y el blanco del papel
pasa a ser transparente.

Valor predefinido de

Valor predefinido de gris blanco y negro

NOTA

Puede hacer doble clic en los valores predefinidos en cualquier momento para abrir el cuadro de
didlogo Vectorization Parameters (Pardametros de vectorizacidn) para personalizar su opcidn.

5. Hagaclicen OK (Aceptar).

Las imagenes vectorizadas aparecerdn en los destinos seleccionados.

NOTA

Si tiene imdgenes de mapa de bits en la libreria, puede arrastrarlas y colocarlas directamente en la
escena como una manera rapida de importar una imagen de mapa de bits. Sin embargo, no tendra
acceso a todas las opciones de importacion.
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Capitulo 9: Colocacion y animacion de capas

La configuracién de una escena se puede comparar con la construccién de la escenografia para un programa de
televisidn. Este es el punto en el que coloca el elemento de escena, como el encuadre de cdmara, los elementos
de fondo vy los personajes.

Colocacién de capas

El primer paso para configurar la escena es colocar cada capa en su posicidn, angulo y tamafio iniciales. Puede
realizar cualquier tipo de transformacién geométrica en una capa con la herramienta .} Transform
(Transformar).

Paneo, rotacidn, escala o sesgo de una capa con la herramienta Transform
(Transformar)

1. En la barra de herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

2. Enlabarra de herramientas de herramientas, si estd habilitado el modo Animate Current Frame
(Animar fotograma actual) o Animate Onion Skin Range (Animar intervalo de papel cebolla) gﬁ,
haga clic en él para abrir el menut emergente Animate (Animar) y seleccione Animate Off (Animar
desactivado) $ .

3. Enlavista de propiedades de la herramienta, asegurese de que la opcién /& Peg Selection Mode
(Modo de seleccién de peg) estd deshabilitada.

4. En lavista de cdmara o de linea de tiempo, haga clic en la capa que desea manipular para
seleccionarla.

CONSEJOS

« Sidesea seleccionar varias capas en la vista de cdmara, mantenga pulsado Mayds y
haga clic en cada capa que desee seleccionar.

« Sidesea seleccionar varias capas en la vista de linea de tiempo, mantenga pulsado
Ctrl (Windows/Linux) o 3 (macOS) y haga clic en cada capa que desee seleccionar.

« Sidesea seleccionar una serie contigua de capas en la vista de linea de tiempo,
mantenga pulsado Mayus, haga clic en la primera capa que desea seleccionar y luego
en la dltima.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

Escalar verticalmente |Sesgar horizontalmente |

Rotar Rotar

| Escalar horizontal y verticalmente 7—' Escalar horizontal y verticalmente |

—| Sesgar verticalmente |

R D—' Escalar horizontalmente |

: Punto de pivote I

D—| Escalar horizontal y verticalmente |

:'1R0tar |

| Escalar verticalmente |Sesgarh0rizontalmente |

| Sesgar verticalmente

| Escalar horizontalmente

1. Realice una de las siguientes acciones:

« Mover: mueva el cursor por lailustracién. Cuando el cursor se convierta en +}#, haga clicy
arrdstrelo sobre la ilustracién para moverla.

« Rotar: coloque el puntero fuera de una esquina del cuadro de limite. Cuando el cursor se
conviertaen ), haga clicy arrdstrelo para rotar.

ﬁ o

« Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del
manipulador. Cuando el cursor se convierta en ", haga clicy arrastre para escalar la capa.
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@ NOTA

Al realizar el escalado de la seleccién, puede mantener pulsado MayUs para
mantener las proporciones entre el ancho vy la altura.

« Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el
cursor se convierta en 1[ , haga clicy arrastre hacia arriba o hacia abajo para sesgar la capa
en vertical.

« Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el
cursor se convierta en ¥, haga clicy arrastre hacia la izquierda o hacia la derecha para
sesgar la capa en horizontal.

Cambio de posicion del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacidn, escala, sesgo y volteo, se
realizan de forma relativa a la posicién del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta rotara
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alrededor de su punto de pivote, y al escalar la capa, se escalard como si su centro fuera realmente su punto de
pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el
pivote de la seleccién. Sin embargo, esto no tiene un efecto permanente. Solo cambiard temporalmente la
posicién del pivote para que le ayude a realizar transformaciones en el fotograma seleccionado, pero el punto de
pivote real de la capa de dibujo permanecerd igual.

Puede cambiar de forma permanente la posicién del punto de pivote de una capa utilizando una de las
herramientas de la barra de herramientas Advanced Animation (Animacién avanzada).

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya estd animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de acuerdo
con la posicién del nuevo punto de pivote. Por lo tanto, la animacidn existente tendrd una
apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que siempre
se asegure de que el punto de pivote se encuentre en la posicién idénea antes de comenzar a
animar.

Cambio de posicion permanente del punto de pivote de una capa

1. Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la herramienta
+I+ Translate (Traslacién), (¥ Rotate (Rotar), ! Scale (Escalar) o /7 Skew (Sesgar).

2. Realice una de las siguientes acciones:
« Enlavista de linea de tiempo, seleccione la capa a la que desee mover el pivote.

« Enlavista de cdmara, utilice Ctrl + clic (Windows/Linux) o &6 + clic (macOS) en la capa para la
que desea mover el pivote.

El punto de pivote @ aparece en la vista de cdmara.

Punto de pivote

3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratdn se convierta en '—& hagaclicy
arrastrelo al punto de pivote para cambiar de posicién.
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El punto de pivote de la capa ha cambiado de posicidn. Si la capa se ha animado, su posicién se
desplazard por las escenas de forma relativa a la cantidad que acaba de desplazar el punto de
pivote.

Animacién de una capa

Puede animar una capa colocandola en diferentes posiciones, angulos y tamafios en distintos puntos a lo largo
de lalinea de tiempo de la escena. Para ello, puede crear fotogramas clave de animacién en la capa. Un
fotograma clave registra las transformaciones geométricas en una capa en un punto especifico en el tiempo.
Cuando dos fotogramas clave de animacidn se encuentren en una capa en diferentes puntos de la linea de
tiempo de la escena, Harmony interpolara automdticamente la posicidn, el dngulo y el tamafio de la capa en
cada fotograma entre esos dos fotogramas clave, creando una animacién.

__| Colocar en el segundo
b | fotograma clave

Colocar en el primer
fotograma clave

[ Colocar para cada fotograma intercalado

Animacién de una capa

1. Enlabarra de herramientas de herramientas, seleccione la herramienta {.I Transform (Transformar)
o pulse Mayus + T.

2. Enlabarra de herramientas de herramientas, si estd seleccionado el modo Animate Off (Animar
desactivado) % o Animate Onion Skin Range (Animar intervalo de papel cebolla) gﬁ, haga clicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual)
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3. Silacapatiene un peg padre:

« Sidesea animar en el peg en lugar de en la capa, asegurese de que el modo /& Peg Selection
(Seleccidn de peg) esté habilitado en la vista de propiedades de la herramienta.

o Sidesea animar directamente en la capa, asegurese de que el modo & Peg Selection
(Seleccidn de peg) esté deshabilitado en la vista de propiedades de la herramienta.

4. En lavistadelinea de tiempo, vaya al primer fotograma.

5. En el menu superior, seleccione Animation (Animacidn) y asegurese de que la opcidn Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no estd marcada. De este modo, Harmony creard la
animacion automdaticamente entre los fotogramas clave de la animacién que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.

7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

Fotograma clave

8. Enlavista de cdmara, seleccione el elemento que desea animar y muévalo, rételo, escélelo o sésguelo
de modo que esté en su posicion de inicio correcta.
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9. Enlavista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicidn.

rno=am
o

10. Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botén derecho en la
seleccién y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en la lista de linea de tiempo, junto con una linea desde el
primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se
animard mediante Harmony.

Fotograma clave

11. En lavista de cdmara, mueva, rote, escale o sesgue el elemento de modo que esté en su segunda
posicién correcta.

12. Enlavista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

13. Enlabarra de herramientas de reproduccidn, haga clic en el botén » Play (Reproducir) para
obtener una vista previa de la animacién.
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NOTA

Sianima capas en el eje Z, puede que desee obtener una vista previa de las animaciones desde
las vistas superior, lateral o de perspectiva durante la reproduccién. Sin embargo, la
reproduccion estd deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en
el menu superior seleccione Play > Enable Playback > Top View (Reproducir > Activar
reproduccidn > Vista superior), Side View (Vista lateral) o Perspective View (Vista de
perspectiva).
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Capitulo 10: Colocaciéon y animacion de la cdmara

En Harmony, puede animar objetos dibujandolos en su capa individual y colocdndolos a continuacidén en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear una ruta de
movimiento. Se puede aplicar el mismo principio a la cdmara de la escena, ya que se trata de una capa.
Adicion de una camara

De forma predeterminada, una escena no tiene capa de cdmara. Para poder ajustar el angulo de la cdmara vy la

posicién de la escena, debe agregar una a su escena.

Adicion de una camara

1. Realice una de las siguientes acciones:

« Enlavistade linea de tiempo, haga clicen el botén 4+, Add Layer (Agregar capa) del
menu emergente y seleccione Camera (Camara).

o En el menu superior, seleccione Insert > Camera (Insertar > Camara).

Se agrega a la escena una nueva capa de cdmara y aparece en la vista de linea de tiempo.

ro=al
o

o

Aunque es posible tener varias cdmaras en la misma escena, solo puede ver su escena utilizando las cdmaras de
una en una. Esto puede resultar Gtil si adn estd trabajando en la composicidn de escena y tiene distintas
configuraciones de cdmara para probar.

Cambio entre camaras

1. En el menu superior, seleccione Scene > Camera (Escena > Camara).

2. Entrelas cdmaras de la lista, seleccione la cdmara con la que desea trabajar.

Adiciéon de un peg padre

Aungue es posible colocar una cdmara sin necesidad de usar un rigging debajo de un peg, se recomienda
hacerlo siempre por dos motivos:

« Permite colocar, rotar y alejar o acercar la cdmara con la herramienta Transform (Transformar).

« Permite animar los movimientos de la cdmara. Sin un peg padre, la posicién, el anguloy el zoom de la
camara son estaticos.
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Adicion de un peg padre a una camara

1. Enlavista de linea de tiempo, seleccione la capa de cdmara.

2. Enlabarra de herramientas Layers (Capas), haga clicen el botén (3 Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de cdmara y se conecta a ella

automaticamente.

Colocacidén de la camara

La accidn de la escena tiene lugar dentro del encuadre de cdmara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolucién de la cdmara y otros pardmetros relacionados en la ventana Scene
Settings (Configuracidn de escena), a la que se puede acceder desde el menu principal de Scene (Escena).

Para cambiar la posicién de la cdmara directamente, puede moverla con la herramienta i1 Transform
(Transformar) o «%» Translate (Traslacién), puede rotarla con la herramienta (¥ Rotate (Rotar) y puede alejarla o
acercarla con la herramienta 7 Scale (Escalar) de la barra de herramientas Advanced Animation (Animacién
avanzada). También puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha
usado un rig de cdmara debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta
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Transform (Transformar). Los siguientes pasos indican cémo manipular la cdmara al usar un rig debajo de un
peg.

Colocacién de una camara en la que se ha usado un rig debajo de un peg en la vista de
camara

1. Realice una de las siguientes acciones para seleccionar el peg padre de la cdmara.

« Enlavista de linea de tiempo, haga clicen la capa del peg padre de la cdmara.

« Enlavista de cdmara, haga clic en el encuadre de la cdmara. El encuadre de la cdmara es un
rectangulo fino alrededor de la etapa de la escena.

Aparece un cuadro de control alrededor del encuadre de la cdmara.

Rotar
Acercar o alegjar

| Acercaroalgjar o

Mowver

Acercar o alejar

Acercar o alejar L

2. Realice una de las siguientes acciones:

« Mover el encuadre de la cdmara: cologue el cursor sobre cualquiera de sus bordes o sobre el
centro. Cuando el cursor cambie a +}+, haga clicy arrdstrelo en el encuadre de la cdmara para
cambiarlo de posicién.
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« Acercar o alejar: coloque el cursor en una de las esquinas del encuadre de la cdmara. Cuando
el cursor cambie a =, haga clicy arrdstrelo a la esquina para cambiar el tamafo del encuadre
de la cdmara. Al contraer el encuadre de la cdmara se acercard la escena, y al expandirlo, se
alejara.

« Rotarla cdmara: coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a
G, haga clicy arrdstrelo para rotar el encuadre de la cdmara.

Animacion de la camara

La cdmara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de linea
de tiempo y puede utilizar las mismas herramientas y modos de seleccién para compensarla o animarla. Sin
embargo, la capa de la cdmara en si es estatica, lo que significa que mantiene la misma posicién y dngulo en toda
la escena. Para poder animar la cdmara, es necesario conectarla a una capa de peg, que se puede animar, y que
afectard directamente a la posicién y al dngulo de la cdmara.

Puede animar los movimientos de la cdmara directamente en la vista de cdmara.
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Animacion de la cdmara

1. Enlabarrade herramientas de herramientas, si esta seleccionado el modo Animate Off (Animar
desactivado) % o Animate Onion Skin Range (Animar intervalo de papel cebolla) gﬁ, haga clicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual)

2. Enlabarra de herramientas de herramientas, seleccione la herramienta .1 Transform (Transformar)
o pulse Mayus + T.

3. Enelladoderecho de la vista de linea de tiempo, en la capa de peg de cdmara, seleccione el
fotograma en el que desee que comience el movimiento de cdmara.

4. Realice una de las siguientes acciones para agregar un fotograma clave:

« En labarra de herramientas de linea de tiempo, haga clicen el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicién de cdmara gque este fotograma clave.

no=am
o

o ] v - = n
[ =

5. En lavista de cdmara, manipule la cdmara para que esté en la posicidn correcta cuando la cdmara
comience a moverse.
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6. Enlavista de linea de tiempo, haga clicen la celda en la que terminard el movimiento de cdmara.

7. Realice una de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén ¢ Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

o Pulse F6.
Aparece un fotograma clave en dicha celda.

ro=al
o
o L]
o

8. Enlavista de cdmara, manipule la cdmara para que esté en la posicién correcta cuando la cdmara
termine de moverse.

9. Enlavistadelinea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.
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10. Enlabarra de herramientas de reproduccidn, haga clic en el botén » Play (Reproducir) para
obtener una vista previa de la animacién.
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Capitulo 11: Creacion de un rig de un personaje Cut-out

En Harmony, un rig de personaje es bdsicamente una plantilla basada en el modelo del personaje, pero en la
cual todas las partes mdviles estén divididas en distintas capas y ordenadas en una jerarquia que facilita la
animacion digital, también conocida como animacién Cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
que partir. Si tiene un dibujo de un personaje disponible, impdrtelo en una nueva escenay, a continuacion,
ajuste la escala y coléquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccién, aprenderd uno de los
métodos mas comunes y sencillos. Para la primera descomposicién de personaje, siga estas instrucciones para
hacerse una idea de cémo funciona Harmony. Una vez que conozca las funciones y comandos bdsicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccidn.

b ‘“’%AQ 00.\\
ﬁUD\\ (

Dibujo de las piezas

La técnica de descomposicidn principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. En lavista de linea de tiempo, agregue una nueva capa de dibujo para cada parte del cuerpo que
desee separar. Puede pulsar Ctrl + R (Windows/Linux) o 36 + R (macOS) para agregar nuevas capas
de dibujo.
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+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1

2. Enlavista de linea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la parte.

3. Enlabarra de herramientas de herramientas, seleccione la herramienta de dibujo que desee.
Existen dos métodos que se suelen utilizar para dibujar las partes de un modelo de personaje Cut-
out:

« Utilizar la herramienta # Pencil (Ldpiz) y suavizar las lineas con la herramienta b3
Smooth Editor (Editor suave).

« Utilizar la herramienta G Polyline (Polilinea). Este método permite dibujar con gran
precision, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor nimero de puntos posible, para
que sean faciles de manipular, modificar o volver a dibujar.

4. En lavista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Cémo pintar en la pagina 46.

5. Siprefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demads capas con colores descoloridos:

« Enlabarra de herramientas de la vista de dibujo, haga clicen el botén ¢ Light Table
(Mesa de luz).

o Pulse MayUs + L.

6. En lavista de cdmara o de dibujo, dibuje la nueva parte.
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7. Sidesea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta (~ Stroke (Linea vectorial transparente).

NOTA

De forma predeterminada, las lineas vectoriales transparentes creadas con la
herramienta Stroke (Linea vectorial transparente) no son visibles. Para ver las lineas
vectoriales transparentes en el dibujo, seleccione View > Show > Show Strokes (Ver >
Mostrar > Mostrar Iineas vectoriales transparentes) en el menu superior o pulse K.

8. En la barra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse ®
Paint Unpainted (Pintar drea no pintada) para colorear el dibujo.

9. En lavista de color, cree el color de relleno deseado si no se encuentra todavia en la paletay, a
continuacion, selecciénelo.

10. En lavista de cdmara o de dibujo, pinte el dibujo.
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11. Enlabarra de herramientas de herramientas, seleccione la herramienta X Select (Seleccionar).
Seleccione el dibujo y acople las lineas haciendo clic en el botén = Flatten (Acoplar) de la vista de

propiedades de la herramienta.

12. Silaslineas estdan compuestas por varios trazos de lapiz, puede que desee combinarlas en una Unica
linea de lapiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las lineas de ldpiz que
se deben combinar vy, en la vista de propiedades de |la herramienta, haga clicen el botén % Merge
Pencil Lines (Combinar lineas de lapiz).

13. Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.
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it H{

Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para compensar y
transformar dibujos que estén debajo de su jerarquia, sin transformar directamente los dibujos.

Al crear un rigging o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo.
De este modo, se permite mantener los fotogramas clave y los dibujos de animacién en capas separadas, lo que
facilita el trabajo sobre la posicidn y exposicidn de las capas de dibujo por separado en la vista de linea de
tiempo. También facilita la creacidn de una jerarquia de las partes del cuerpo que se pueden animar juntas y por
separado.

el —

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccidn de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas de
dibujo de animacidn, ya que solo se pueden animar los pegs.
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NOTA

También es posible hacer que una capa de dibujo sea el padre de otra capa de dibujo. Al igual que la
forma de animacién de un peg anima sus capas hijas, la animacién de una capa de dibujo con hijos
también animarad sus capas hijas. Ambas capas seguirdn apareciendo en la animacidn.

Emparentar pegs a las capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione todas las capas.

+
|

¥

#

+++++

L]
L]
L]
L]
L]
L]
L]
L]
L]
L]

2. Enlabarra de herramientas de capa de linea de tiempo, haga clicen el botén (% Add Peg (Agregar
peg) para agregar un peg padre a todas las capas seleccionadas.

)

ok

Creacion de una jerarquia de capas

Harmony permite crear el rig en una jerarquia elaborada, lo que permite a su vez establecer qué partes del rig
deben influir en otros miembros y cémo pueden moverse de forma independiente. Por ejemplo, al crear un
rigging del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo, y
que la capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el antebrazo, la
mano también lo hard, y si mueve el brazo, el antebrazo y la mano también lo haran.
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Jerarquia de brazo
derecho

Jerarqwa de

Jerarqma de pierna
derecha pierna lzquterda

Al crear un rig de personaje bdsico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede

crear una jerarguia que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de las
piernas a las caderas. Esto crearia una jerarquia como esta:

Creacion de una jerarquia en la vista de linea de tiempo

1. En el dreaizquierda de la vista de linea de tiempo, seleccione la capa que desee que sea la capa hija.

2. Arrastre el hijo y coléquelo sobre la capa que desee que sea la capa padre. Aseglrese de no colocar
la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que manipule todas las partes del personaje,
con un peg maestro en la raiz. Al crear un rig, si desea que varias capas tengan un padre comun,

pero ninguna de las partes existentes del rigging puede servir como dicho padre, cree un nuevo peg
y anide esas capas debajo de dicho peg.
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Sin pegs

+ “+ (% +
+ + +
+ + +
+ + +
+ + +
+ + +
+ + +
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NOTA

En la vista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
presionada la tecla Mayus, arrastrando la capa padre lejos de la capa hija y colocandola en
cualquier lugar de la lista.

Al crear un rigging, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en
que se representan. Las capas de la parte superior de la lista se representaran sobre las capas de la parte
inferior de la lista. Si tiene que cambiar el orden de una capa durante la animacidn, puede realizar un
desplazamiento pequefio de la posicién de esta capa sobre el eje Z para anular el orden de la capay forzarla a
aparecer debajo o sobre otras capas.

Desplazamiento pequeno de una capa sobre el eje Z

1. Enlabarrade herramientas de herramientas, seleccione la herramienta i.: Transform
(Transformar).

2. Enlavista de linea de tiempo, de nodos o de cdmara, seleccione la capa que desea desplazar.

3. Siha seleccionado la capa en la vista de linea de tiempo o de nodos, haga clicen la pestafia de la
vista de cdmara para establecer el enfoque en esta vista.

4. Realice una de las siguientes acciones:

« Pararealizar un desplazamiento pequefno de la capa hacia delante, pulse Alt + flecha
abajo.

« Para realizar un desplazamiento pequefio de la capa hacia atras, pulse Alt + flecha
arriba.
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Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. El peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
Util para colocar y escalar el personaje en relacidén a la escena, asi como para animar la trayectoria del personaje
cuando tiene que moverse entre las dreas de la escena.

Adicién de un peg maestro en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione la capa superior.
2. Enlavista delinea de tiempo, haga clicen el botén (% Add Peg (Agregar peg).

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
3. Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. Enlavistadelinea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde
gue la capa superior ya es un hijo del peg, asi que no lo incluya en la seleccién.

5. Arrastre la seleccion SOBRE la capa del peg para emparentar todas las piezas del personaje al peg.
Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de
nuevo a la parte superior de la pila de capas.
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Capitulo 12: Animacion de un personaje Cut-out

Harmony ofrece herramientas muy Utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacién con objeto de permitir
combinar los cambios del movimiento y del dibujo para crear animaciones Cut-out perfectamente ajustadas.

Creacion de una animacién Cut-out simple

Crearemos una animacién Cut-out simple realizando la primera pose del personaje en el primer fotograma,
la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. Enlavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempoy
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.
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4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas de
la escena y confirme. De este modo, el modelo quedara expuesto (sera visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mds tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

o Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. Enlabarra de herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

7. Enlabarra de herramientas de herramientas, si esta seleccionado el modo Animate Off (Animar
desactivado) % o Animate Onion Skin Range (Animar intervalo de papel cebolla) g\%, haga clicen él
para abrir el menld emergente Animate (Animar) y seleccione Animate Current Frame (Animar

fotograma actual)

8. En lavista de cdmara, seleccione las partes que desea animar. El cuadro de control de la herramienta
Transform (Transformar) aparecera alrededor de la capa seleccionada. Cada parte del cuadro de
control de la herramienta Transform (Transformar) se puede usar para realizar distintos tipos de
transformaciones:

Cambiar
tamano

[ Sesgar |—>

109



Capitulo 12: Animacién de un personaje Cut-out

9.

10.

11.

12.

13.

Utilice la herramienta | Transform (Transformar) para rotar, sesgar, escalar o trasladar la seleccién
a su nueva posicion.

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.
En la barra de herramientas de herramientas, active la funcién é Onion Skin (Papel cebolla).

En la vista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

3

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

« En labarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

El segundo fotograma clave aparece, junto con una linea desde el primer fotograma clave al segundo
fotograma clave. Esto indica que cada fotograma intercalado se interpolara mediante Harmony.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un fotograma
clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

« Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o & + K (macOS)
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Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de
forma predeterminada, seleccione Animation (Animacidén) en el menu superior y asegurese de que la
opcidn Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Los fotogramas entre dos fotogramas clave estdn interpolados
por Harmony si el primero de los dos fotogramas clave es un fotograma clave de
movimiento.

14. En lavista de cdmara, cambie de nuevo la pose del personaje.

Capa
seleccionada

15. Repita este proceso para todas las poses que desee agregar a la animacion.

Ajuste de la velocidad de la animacién

1. Enlavista de linea de tiempo, contraiga la jerarquia del modelo del personaje.

2. Seleccione uno de los fotogramas clave de la animacidn. Mientras que la jerarquia del modelo se
contrae, esto selecciona el fotograma clave en cada capa simultdneamente.

3. Realice una de las siguientes acciones:

« Enlavista de linea de tiempo, haga clic con el botdn derecho y seleccione Set Ease For
Multiple Parameters (Definir aceleracion para varios pardmetros).
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o Enlabarrade herramientas de linea de tiempo, haga clic en el botén =~ Set Ease For
Multiple Parameters (Definir aceleracidn para varios parametros).

Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios

pardmetros).

EEEEEE

Apply fPrevious Apply Apply

4. En el gréfico, tire del controlador de curva Bézier para ajustar la velocidad de todas las funciones

seleccionadas.

5. Para aplicar estos pardametros de velocidad Unicamente a un tipo de funcién determinado, como
Rotation (Rotacidn) o Scale (Escala), en la seccién Filters (Filtros), anule la seleccién de los tipos de
funcidn a los que no desee que se apliquen.

« Motion (Movimiento): aplica los pardmetros de velocidad a las funciones Position X
(Posicidén X), Position Y (Posicién Y), Position Z (Posicién Z) y 3D Path (Ruta 3D)
seleccionadas.

« Rotation (Rotacién): aplica los pardmetros de velocidad a las funciones de dangulo
seleccionadas.
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« Scale (Escala): aplica los pardmetros de velocidad a las funciones de escala
seleccionadas.

o Skew (Sesgar): aplica los pardmetros de velocidad a las funciones de inclinacién
seleccionadas.

« Morphing: aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que se aplica cuando la funcién Morphing
Velocity (Velocidad de morphing) de la ventana Layer Properties (Propiedades de
capa), no es la velocidad de morphing bdsica en la vista de propiedades de la
herramienta.

o Other (Otras): aplica los parametros de velocidad a todas las demas funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

6. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de
tiempo) y Value Ratio (Ratio de valor). Los valores se calculan como un porcentaje.

e Enlos campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que
desea que dure la velocidad. El valor debe estar entre el 0 % y el 100 %.

o En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de
valor derecho), escriba el valor como porcentaje correspondiente a la intensidad que
desea que tenga la desaceleracion. El valor debe estar entre el 0 %y el 100 %.

« Silos valores Time Ratio (Ratio de tiempo) y Value Ratio (Ratio de valor) son iguales, el
movimiento serd lineal.

7. Haga clicen uno de los siguientes botones:

« Apply/Previous (Aplicar/anterior): aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona seleccione el fotograma clave
anterior en la linea de tiempo.

« Apply (Aplicar): aplica los pardametros de velocidad a los fotogramas clave
seleccionados.

« Apply/Next (Aplicar/siguiente): aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona el fotograma clave siguiente en la
linea de tiempo.

« Close (Cerrar): cierra el cuadro de didlogo. Si no ha aplicado las modificaciones, se
cancelaran.
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NOTA

Si se selecciona un rango que contiene varios fotogramas clave, solo el primer fotograma clave
seleccionado se verd afectado por la funcién Set Ease for Multiple Parameters (Definir

aceleracidn para varios parametros).

Desplazamiento por las capas

Dado que la animacién Cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los
atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccién), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea de
tiempo. Por lo tanto, puede usar la vista de cdmara para seleccionar de forma visual la capa con la que desee
trabajar y, a continuacién, usar el atajo de Centre on Selection (Centrar en seleccién) para encontrar la capa en
la vista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccion actual en la vista de linea de tiempo

1. Enlavista de linea de tiempo, contraiga todas las capas.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta i.} Transform
(Transformar).

3. Enlavista de cdmara, seleccione una capa.
4. Realice una de las siguientes acciones:

« Hagadlicen la pestana de la vista de linea de tiempo para ajustar el centrado en la

mismay, a continuacion, pulse O.

« Enlabarrade herramientas de la vista de linea de tiempo, haga clic en el botén
Centre on Selection (Centrar en seleccidn).

La vista de linea de tiempo estd ahora centrada en la capa seleccionada y todos sus padres se han

expandido automdaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer que es pesado tener que hacer clicen la
pestafia de vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse
Enter (Centrarse en ratdn). Ajustard el centrado en una vista en cuanto el cursor del ratdn entre en ellay hard
funcionales al instante todos los atajos de teclado de esta vista.
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Activacién de la preferencia Focus On Mouse Enter (Centrarse en ratoén)

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enla seccién Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse

en ratdn).
4. Haga clicen OK (Aceptar).

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratén entre en la

vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rdpidamente la seleccién de la capa
seleccionada actualmente a su su padre, su hijo o uno de sus hermanos, permitiendo asi el desplazamiento con
rapidez por la jerarquia del personaje desde una capa a una de sus capas relacionadas.

Seleccién del padre o del hijo de la capa seleccionada

1. Enlabarrade herramientas de herramientas, seleccione la herramienta .1 Transform

(Transformar).

2. Enlavista de propiedades de la herramienta Transform (Transformar), asegurese de que esté
desactivado el modo A& Peg Selection (Seleccién de peg).

3. Enlavista de cdmara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

)

Y

) O

Q

4. Realice una de las siguientes acciones:

« Seleccione Animation > Select Parent (Animacién > Seleccionar padre) o pulse B para

seleccionar la capa padre.

o Seleccione Animation > Select Child (Animacién > Seleccionar hijo) o pulse Mayus + B para

seleccionar la capa hija.
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« Seleccione Animation > Select Children (Animacién > Seleccionar hijos) para seleccionar

todas las capas hijas al mismo tiempo.

NOTA

Al subir o bajar la jerarquia de nodos, estos atajos de teclado omiten cualquier nodo de efecto
de la jerarquiay solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se
optimizan para la animacién Cut-out. En el cuadro de didlogo Keyboard Shortcuts (Atajos de
teclado), en la seccidén General, estos atajos de teclado se denominan Select Parent Skipping
Effects (Seleccionar efectos de omisién del padre) y Select Child Skipping Effects (Seleccionar
efectos de omisidn del hijo). Si desea utilizar los atajos de teclado para navegar por la jerarquia
sin omitir los nodos de efectos, puede asignar atajos de teclado personalizados para los
comandos Select Parent (Seleccionar padre) y Select Child (Seleccionar hijo).

Seleccidn de los hermanos de la capa seleccionada

1. Enlavista de linea de tiempo, seleccione una capa que tenga al menos un hermanoy realice una de
las siguientes acciones:

o Para seleccionar el hermano previo de la familia, pulse /.

o Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de
interrogacion (?).

+
|

¥

#

Hermano anterior
Siguiente hermano

i1
i)
i)
i)
o
o
o
o
o
i)
i)

(| | [+
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Capitulo 13: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Las deformaciones funcionan mediante la creacién de puntos de control en un dibujo.
Al mover dichos puntos, el dibujo se dobla o distorsiona de modo que las partes del dibujo que estan vinculadas
a un punto de control siguen dicho punto al lugar donde lo posicione.

Los deformadores pueden aumentar considerablemente el rango de movimientos y animaciones que el rig de
un personaje Cut-out sea capaz de realizar sin necesidad de dibujar nuevas poses o recurrir a la animacién
fotograma a fotograma. Un personaje Cut-out en rig con deformaciones se puede animar de una forma que se
asemeje a la fluidez y flexibilidad de la animacidn tradicional. Ademds, los deformadores se pueden utilizar para
modificar, mejorar o facilitar la animacidn fotograma a fotograma cuando sea necesario.

Los deformadores funcionan al crear un rigging con ellos en la parte del cuerpo que desee deformar, crear una
estructura de deformacion vy, a continuacién, animarlo. Se puede realizar facilmente con la herramienta §{T

Rigging.
Hay dos tipos de deformadores disponibles en Harmony Advanced:
o Hueso

o Hueso para juego

Deformador de huesos

La deformacién de hueso permite crear una estructura similar al hueso en la que cada parte es sdlida, pero las
articulaciones son flexibles. Esto es sobre todo (til para la animacidn de los miembros de un personaje, como los
brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos.

Por ejemplo, se puede utilizar una deformacién de hueso para articular un brazo que estd hecho de un solo
dibujo, de modo que el brazo y el antebrazo se puedan mover de forma independiente, sin necesidad de dibujar
la parte superior del brazoy el antebrazo en capas diferentes. Harmony deformara el dibujo para que parezca
que esta articulado. Las distintas partes de una deformacién de hueso se pueden rotar alrededor de su
articulacién, extenderse y acortarse, proporciondandole las mismas capacidades que las articulaciones de
animacion en distintas capas, sin tener que preocuparse por la separaciéon de piezas, puntos de pivote o recorte
de contornos.
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Articulacién

Deformador de hueso para juego

La deformacién de hueso para juego es parecida a la deformacién de hueso. Le permite crear estructuras
compuestas de puntos, que representan las articulaciones, y segmentos de lineas rectas vinculando dichos
puntos que representan los huesos. La deformacién de hueso para juego es diferente, ya que se optimiza para
motores de juego como Unity. Por lo tanto, generalmente solo se usa para personajes animados destinados a
ser importados a juegos de Unity, y no para producciones de animacién.

A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una propiedad de
sesgo. Los pliegues de la articulacién también parecen ligeramente mds redondos.

Radio de ="

articulacion

Articulacién

Creacién de deformadores

La manera mds sencilla de crear deformadores es usar la herramienta {T Rigging, disponible en la barra de
herramientas de deformacidn. Con esta herramienta, todo lo que necesita hacer para crear un deformador es
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seleccionar la capa que desee deformar y, a continuacidn, colocar cada punto del deformador en la vista de
cédmara.

Los deformadores existen en la escena como una jerarquia de capas de deformacién. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la
jerarquia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacién del
hombro, el segundo punto debe ser el codo y el tercero, la muneca.

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta Rigging, se crea automaticamente como padre de la capa seleccionada, y afectard a la
capa seleccionada y a todos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de intentar
crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazoy el brazo se divide en varias capas, se puede crear

un rig del brazo en una jerarquia donde el brazo superior sea la raiz, el antebrazo sea el hijo del brazo superior y
la mano sea el hijo del antebrazo. A continuacidn, si crea su deformador en la parte superior del brazo, se creara
como padre de la parte superior del brazoy, por lo tanto, afectard a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los hijos
de este peg. Esto se debe a que es probable que un peg sea mas Util sobre un deformador que debajo de él. Si
mueve las capas que estan debajo de un deformador, saldran de la zona de deformacidn prevista y pueden
aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones posibles debajo
de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el deformador se queda
intacto. Dado que el deformador se creard como padre de todos los hijos del peg, afectard a todas las capas que
haya debajo de este.

Creacién de un deformador de huesos

1. Una vez seleccionado el elemento, seleccione la herramienta {T Rigging en la barra de
herramientas de deformacién.

2. En lavista de propiedades de la herramienta, habilite el modo < Bone (Hueso).
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3. Hagaclicen el lugar donde desee crear la articulacién de raiz de la estructura ésea. La articulacién de
raiz deberia ser la que esté vinculada al resto del cuerpo. Por ejemplo, en un brazo, la articulacién de
raiz serfa el hombro.

4. Hagaclicen el lugar donde desee crear la segunda articulacion.

Se creara un hueso entre la primera y la segunda articulacidn.

5. Hagaclicen el lugar donde desee crear la siguiente articulacion.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacién, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacién. Cada punto de un deformador de hueso, a excepcidn del primero y del dltimo, cuenta
con un radio.

6. Haga clicy mantenga pulsado el punto de control del radio de la articulacién anterior y ajuste el radio
de la articulacién de modo que cubra la articulacién correctamente.

7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Aseglrese de crear cada
articulacién en el orden correcto desde la raiz hasta la extremidad.
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Visualizacion de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de cdmara independientemente de la
seleccidn actual. Al crear una cadena de deformacidn, sus controles de deformacidn se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacidn no se mostraran automaticamente. Asimismo, al desactivar una
cadena de deformacién no se ocultardn sus controles de deformacion.

Para poder animar o modificar una cadena de deformacién existente, debe mostrarla de forma manual.

Visualizacion de los controles de deformacion

1. Realice una de las siguientes acciones:

« Enlavista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas a
la cadena de deformacidn que desee visualizacion.

« En lavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién que
desee visualizacion.

2. Enlabarra de herramientas de deformacion:

o Hagaclicen el botén © Show the Selected Deformation Chain and Hide All Others (Mostrar
la cadena de deformacidn seleccionada y ocultar el resto) para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacidon que se
muestra.

« Hagaclicen el botén 2~ Show Selected Deformers (Mostrar deformadores seleccionados)
para mostrar la cadena de deformacidn del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestra.

Los controles de deformacién aparecen en la vista de camara.

NOTA

El botdn Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacidn seleccionada y ocultar el resto) mostrard todas las cadenas de deformacion que se
encuentran en la jerarquia de la seleccidon. Por ejemplo, si estd seleccionado el peg maestro de
un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si estan
seleccionadas varias capas vinculadas con distintas cadenas de deformacidn, se mostraran
todas sus cadenas de deformacion.

Ocultar los controles de deformacién

1. Realice una de las siguientes acciones:
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« Haga clicen el espacio negativo de la vista de cdmara, de linea de tiempo o de nodos
para descartar la seleccién actual y, a continuacién, haga clicen el botén 2~ Show the
Selected Deformation Chain and Hide All Others (Mostrar la cadena de deformacién
seleccionada y ocultar el resto) de la barra de herramientas de deformacion.

« Seleccione una capa que no esté vinculada a ningun deformador vy, a continuacidn,
haga clicen el botén 2~ Show the Selected Deformation Chain and Hide All Others
(Mostrar la cadena de deformacién seleccionada y ocultar el resto) de la barra de
herramientas de deformacidn.

« Enlabarrade herramientas de cdmara, haga clic en el botdn 2 Hide All Controls
(Ocultar todos los controles).

« En el menu superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

o Pulse Mayls + C.

Animacion con deformadores

Aligual que con los pegs de animacidn y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacién de deformadores funciona
exactamente igual que la realizacién de modificaciones en un deformador, excepto que requiere el uso de la
herramienta ! Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la herramienta
Transform (Transformar), los controles de deformacién de la vista de cdmara se muestran en color verde, lo que
significa que se encuentran en modo de animacién, mientras que cuando se selecciona la herramienta Rigging,
se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacién de deformaciones de hueso y hueso para juego

1. Enlavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:
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« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas de
la escena y confirme. De este modo, el modelo quedara expuesto (sera visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mds tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. Enlabarra de herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

7. Enlabarra de herramientas de herramientas, si estd seleccionado el modo Animate Off (Animar
desactivado) % o Animate Onion Skin Range (Animar intervalo de papel cebolla) g\%, haga clicen él
para abrir el menld emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual)

8. Realice una de las siguientes acciones:

o Enlavista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas a
la cadena de deformacién que desee animar.

« Enlavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién que
desee animar.

9. En la barra de herramientas de deformacidn:

« Hagaclicen el botén © Show the Selected Deformation Chain and Hide All Others (Mostrar
la cadena de deformacidn seleccionada y ocultar el resto) para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que se
muestra.
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« Hagaclicen el botén 2~ Show Selected Deformers (Mostrar deformadores seleccionados)
para mostrar la cadena de deformacién del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestra.

Los controles de deformacién aparecen en la vista de cdmara.
10. En lavista de cdmara, realice lo siguiente:

« Pararotar el miembro entero, haga clicy arrastre el primer hueso. Esto girara el primer
hueso y todos los huesos subsiguientes.

o Paradoblar el miembro, haga clicy arrastre otro hueso. Esto girard el hueso y todos los
huesos subsiguientes, pero dejard los huesos anteriores en su posicién actual.

o Para cambiar una articulacién de posicién, haga clicy arrastre su punto de control. Esto
se puede utilizar para rotar, reducir o extender el hueso, y desplazarad todos los huesos
subsiguientes.
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« Parareducir o extender un hueso sin rotarlo, mantenga pulsada la tecla Alt y, a

continuacién, haga clicy arrastre su punto de control.

« Para desplazar el miembro entero, haga clicy arrastre su punto de raiz.

4 \

Q- CONSEJO

También puede realizar un desplazamiento pequefio de una articulacién
en cualquier direccién seleccionandola y, a continuacién, pulsando las

teclas de flecha.

11. Enlavista de linea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.
12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén * Add

126



Guia de introduccién de Harmony 17 Advanced

Keyframe (Agregar fotograma clave).
« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.
13. Transforme el punto del deformador para crear su nueva pose clave.

14. Repita los pasos anteriores hasta que la animacion haya terminado.
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Capitulo 14: Importaciéon de sonido y sincronizacion de labios
4_._/; < g - ) 3 "
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Importacion de sonido

Si desea agregar sonido a la animacién, es recomendable que edite y mezcle los archivos de sonido en un
software de edicién de sonido. Al tener pistas de sonido de larga duracién mezcladas previamente, se garantiza
gue el sonido conserve su tiempo, mezcla y calidad si utiliza software de terceros para la postproduccién. Otra
buena préctica es mantener la pista de sonido separada en pistas de musica, efectos de sonido y personajes
para facilitar la sincronizacion de la animacidn con voces y sonidos. De lo contrario, es posible recortar los
efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como escenas
separadas de Harmony. La pista de sonido del storyboard se cortard por escenay cada pieza se insertard en las
escenas exportadas, lo que permite ahorrar tiempo en la divisidon e importacién de la pista de sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

La importacién de una pista de sonido mds larga que la escena no ampliard la longitud de esta
dltima. La reproduccién de sonido se detendrd al final de la duracién de la escena.

Importacién de un archivo de sonido

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramasy seleccione Import > Sounds (Importar > Sonidos).

o En el menu Xsheet (Carta de rodaje), seleccione File > Import > Sounds (Archivo >
Importar > Sonidos).

o En el mend Timeline (Linea de tiempo), seleccione Import > Sounds (Importar >
Sonidos).

Se abre el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido).

2. En el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.
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El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido de
la pista de sonido.

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de forma predeterminada. Si lo desea, puede visualizar la forma de
onda de una columna de sonido haciendo clic con el botdn derecho en ella y seleccionando Sound
Display > Waveform (Visualizacién de sonido > Forma de onda).

Voice

voicewav

|

Deteccidon automatica de sincronizacién de labios

La adicidén de la sincronizacién de labios a la animacién es fundamental para que parezca que los personajes
estdan vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacién.

e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automdtica de sincronizacién de
labios. Esta funcién analiza el contenido de una pista de sonido de la escena y asocia cada fonema que detecta
con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estdndar de la
industria de la animacioén.
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Boca
NOTA

Las letras asignadas a estas formas de boca son identificadores estdndar y NO se corresponden con
el sonido que se pretende producir.

Esta es una aproximacidn de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e« A:m,b,p,h
e B:s,d,jik,t
e Cea
« D:AE
« E:0
e Fiu
o« G:f ph
« X:silencio, sonido indeterminado

Al realizar la deteccién automatica de sincronizacién de labios, Harmony no crea dibujos de boca. Simplemente
rellena la columna de dibujo de la capa de la boca del personaje con la sincronizacién de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que la
deteccidén automatica de sincronizacion de labios funcione, la capa de la boca del personaje ya debe contener un
dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de su letra
correspondiente.

Generacion de una deteccion de sonido para sincronizacion de labios mediante la vista
de propiedades de capa

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione la capa de sonido.

130



Guia de introduccién de Harmony 17 Advanced

Las opciones para dicha capa aparecerdn en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).

Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizacién de labios a
cada celda de sonido.

3. Hagaclicen el botén Map (Asignar) para abrir el cuadro de didlogo Lip-Sync Mapping (Asignacion
de sincronizacién de labios).

4. En el mend Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la

boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacion de labios
utilizando dibujos situados directamente en la capa o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ninguin simbolo) si desea utilizar los dibujos o el simbolo deseado del
menu desplegable.

5. En la seccién Mapping (Asignacién), escriba el nombre del dibujo o los fotogramas del simbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las
letras del fonema, puede saltarse este paso.

6. Hagaclicen OK (Aceptar).
7. Enlabarra de herramientas de reproduccién, habilite la opcién #) Enable Sound (Habilitar sonido).

8. Pulse el botén » Play (Reproducir) en la barra de herramientas de reproduccién para ver y oir los
resultados en la vista de cdmara.

Si tiene que realizar ajustes a la sincronizacién de labios generada automaticamente, consulte
Animacién manual de sincronizacidn de labios en la pagina 132.

Animacion manual de sincronizacidon de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca debe
exponerse en cada fotograma del cuadro del didlogo de su personaje. Para este proceso, utilizard la funcién
Sound Scrubbing (Depuracién de sonido), que reproduce la parte de la pista de sonido en el fotograma actual
cada vez que mueva el cursor de la linea de tiempo, lo que permite identificar los fonemas que debe hacer
coincidir con la boca de su personaje. También se utilizara un dibujo de sustitucién para cambiar el dibujo de la
boca gue se expone en cada fotograma.

Animacion de sincronizacion de labios utilizando la vista de linea de tiempo

1. Enlabarrade herramientas de reproduccién, haga clic en el botén €S Sound Scrubbing
(Depuracidon de sonido).

2. Enlavista delinea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de onda
de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. En la seccion Parameters (Pardmetros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al
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puntero de intercambio ‘{5

5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. El dibujo
actual se cambia automaticamente a la nueva seleccién.

Animacion de sincronizacién de labios utilizando la vista de libreria

1. Enlabarrade herramientas de reproduccién, haga clic el botén €S Sound Scrubbing (Depuracién
de sonido).

2. Enlavista de linea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de onda
de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. Enlaventana Drawing Substitution (Sustitucién de dibujo) de la vista de librerfa, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de vista previa.
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Capitulo 15: Adicion de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacidn esté terminada, puede agregar
efectos, como desenfoques, brillos, sobras, filtros de color y de transparencia, asi como mejorar la calidad del
proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una capa
de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se aplican
al elemento al que estdn conectados. Esto proporciona flexibilidad a la hora de decidir a qué elementos de |a
escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el drea ala
que deben afectar. Un buen ejemplo de ello es el efecto de tono, que se usa para agregar una sombra de una
forma determinada a una capa. De forma independiente, el efecto de tono no tiene ningin impacto en el dibujo
al que estd conectado. Una vez combinado con una capa de mate, el efecto de tono usard la forma del mate para
aplicar una sombra al dibujo. Incluso si la forma del mate sale fuera de los contornos del dibujo, la sombra solo se
aplicard dentro de los contornos del dibujo.
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Una capa de mate es una capa de dibujo habitual que estd conectada a un efecto como su mate. El efecto toma
la forma del dibujo en la capa de mate para determinar el drea del dibujo a la que afecta. Los colores y detalles
de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En la vista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
que debe afectar.

Si el efecto puede usar una capa de mate, tendrd un pardmetro de mate al ampliar la lista de pardmetros. Puede
arrastrar y colocar la capa en la que desee usar un mate para el efecto en el pardmetro de mate del efecto para
vincularlos.

Si el efecto puede usar una capa de mate, tendrd un puerto de mate a su izquierda al que se puede conectar la
capa de mate.

Una vez que el efecto estd conectado, puede ajustar sus pardmetros seleccionandolo y, a continuacion,
ajustando sus pardmetros en la vista de propiedades de capa. También puede hacer doble clic en la capa para
abrir su cuadro de didlogo de propiedades de capa. Sise desea, incluso puede animar los pardmetros del efecto
convirtiendo sus valores a funciones.

Adicion de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efectoy, a
continuacion, agregando el efecto a través del menud Add Layers (Agregar capas) de la vista de linea de tiempo.
A continuacién, puede conseguir el efecto previsto ajustando los pardmetros en la vista de propiedades de capa
y conectdndolos a una capa de mate, seguiin proceda.

Adicién de un efecto
1. Enlavista de linea de tiempo, seleccione la capa en la que desee agregar un efecto.

2. Realice una de las siguientes acciones:

« En el menu superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el
efecto que desea agregar.
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o Enlabarrade herramientas Layers (Capas) situada encima de la lista de capas, haga
clicen el botén 4+, Add Layers (Agregar capas), seleccione Effects (Efectos) y, a
continuacion, seleccione el efecto que desee agregar.

« Haga clic con el botdn derecho en la capa, seleccione Insert > Effects (Insertar >
Efectos) y, a continuacidn, seleccione el efecto que desee agregar.

El efecto aparece en la vista de linea de tiempo, debajo de la capa seleccionada.

3. Enlavista de cdmara, haga clicen el botén Render View (Vista de render) para ver el fotograma

y el efecto actuales renderizados de la escena.

NOTA

El fondo aparecerd en negro de forma predeterminada. Para corregirlo, puede
agregar una capa de la carta de color en la parte inferior de la lista de capasy
cambiar su color en la vista de propiedades de capa.

4. En lavistadelinea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los pardmetros disponibles para el efecto
seleccionado.

5. Enlavista de propiedades de capa, ajuste los parametros del efecto segin sea necesario.

NOTA

Cada vez que realice un cambio, la vista de cdmara tendrd que actualizar la imagen
renderizada, lo cual puede provocar una ligera demora antes de que pueda observar el
efecto.
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6. La mayoria de los efectos no se reproduciran en tiempo real en Harmony. Para reproducir la escena
con los efectos finales, haga clicen el botén B Render and Play (Renderizar y reproducir) de la
barra de herramientas de reproduccién de la barra de herramientas de la vista de linea de tiempo.

NOTA

Una vez que haya establecido los pardmetros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rdpidamente sin necesidad de volver a establecer
los pardmetros; consulte Creacidn y uso de plantillas en la pagina 170.

Adicién de un efecto con un mate

El siguiente tutorial muestra cémo usar el efecto de cuchilla con un mate. En Harmony, varios efectos usan mates
para determinar el drea de la imagen a la que afectan.

El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptara la forma del dibujo de la capa de matey
cortard esta forma de la capa de dibujo. Esto es especialmente Util si desea que un personaje desaparezca entre
un elemento de fondo, o si desea realizar un agujero en el centro de un personaje.

Al igual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un pardmetro Inverted (Invertido),
que esta deshabilitado de forma predeterminada. Cuando estd habilitado, la cuchilla tendra el efecto contrario:
en lugar de cortar la forma del mate del dibujo, cortara todo lo que se encuentre fuera de la forma del mate del
dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate.

Uso del efecto de cuchilla

1. Seleccione una capa de dibujo.
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2. Realice una de las siguientes acciones:

o Enlabarrade herramientas sobre la lista de capas en la vista de linea de tiempo, haga clicen
el botén +, Add Layer (Agregar capa) y seleccione Effects > Cutter (Efectos > Cuchilla).

« Haga clic con el botén derecho en la capa y seleccione Insert > Effects > Cutter (Insertar >
Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

1. Enlabarrade herramientas sobre la lista de capas en la vista de linea de tiempo, haga clicen %%
Add Drawing Layer (Agregar capa de dibujo).

2. En el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo), asigne a la nueva capa de
dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuacién, haga
clicen Add and Close (Agregary cerrar).

3. Enla nueva capa de dibujo de mate, dibuje un mate para el efecto. El mate puede ser una forma
simple, pero se debe rellenar con un color, ya que solo se tendrdn en cuenta las partes del mate que
sean opacas.

NOTA

Los mates también pueden tener dreas semitransparentes. Las dreas del dibujo
cubiertas por dreas semitransparentes del mate se ven parcialmente afectadas por el
efecto.
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4. En lavista de linea de tiempo, haga clic en el botén + Expand (Expandir) situado a la derecha de la

capa Cutter (Cuchilla).

5. Arrastre y coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo
de la columna Parameters (Pardmetros).

La capa de dibujo de mate se convierte en el mate de la capa Cutter (Cuchilla). En este punto, las
dreas de lailustracidn que se cruzan con la ilustracién de la capa de dibujo de mate estan ocultas.

6. Sidesea invertir el efecto de cuchilla, para que la ilustracién que se cruza con lailustracién de la capa
de mate sea visible y todo lo demds esté oculto, haga doble clic en la capa Cutter (Cuchilla) (pero no
en sunombre) para abrir su cuadro de didlogo de propiedades de capay, a continuacién, marque el
pardmetro Inverted (Invertido).

Otros dos ejemplos de efectos que funcionan con mates son los efectos de tono y resaltado. El efecto de tono
aplica una sombra a su dibujo basada en su mate, mientras que el efecto de resaltado aplica un resaltado a un
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dibujo basado en un mate. Estos efectos no se aplican fuera de los dibujos a los que estdn conectados, de modo
que solo tiene que dibujar los resaltados y la sombra del personaje en las capas de mate sin preocuparse por
dibujar fuera del trazado.

La adicidn de estos efectos a un dibujo funciona exactamente igual que la adicién de una cuchilla a un dibuijo,
salvo que tienen pardmetros adicionales para configurar el color, la intensidad y el renderizado del efecto.

Animacion de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede
desear que el radio de un efecto de brillo aumente y disminuya lentamente para hacer que vibre a lo largo de
una escena, o puede desear que la transparencia de un efecto de transparencia aumente de 0 % a 100 % para
hacer desaparecer un dibujo.

Casi todos los pardmetros numéricos de un efecto se pueden unir a una funcién. Una funcién permite definir un
parametro para distintos valores en diferentes puntos de la escena agregdndole fotogramas clave y definiendo
cada fotograma clave en un valor especifico. Entre fotogramas clave, el valor del pardmetro avanzard desde el
valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de dibujo se animan
asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar asociando sus
pardmetros a funciones.

Algunos pardametros de efectos se pueden animar directamente en la vista de linea de tiempo, pero no todos. Al
expandir los pardmetros de un efecto en la vista de linea de tiempo, algunos de sus pardmetros pueden estar
ocultos para evitar saturar la vista de linea de tiempo. Puede animar esos parametros desde la vista de
propiedades de capa o el cuadro de didlogo de propiedades de capa, que muestra todos los pardmetros de una
capa.
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Animacién de un parametro de efecto en la vista de linea de tiempo

1. Enlavista de linea de tiempo, localice el efecto que desea animar y haga clic en el botén 4 Expand
(Expandir) situado a la derecha de su nombre.

Aparece en la vista de linea de tiempo la lista de pardmetros que muestra los parametros de efectos
disponibles.

ro=al
o
o ||

o+ | [+ +

2. En el drea derecha de la vista de linea de tiempo, en la misma fila que el pardmetro que desee
animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animacién para el
efecto.

3. Cree un fotograma clave realizando una de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.
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4. En el drea delaizquierda de la vista de linea de tiempo, debajo de la columna Parameters
(Pardmetros), ajuste el valor del pardmetro para este fotograma clave realizando una de las
siguientes acciones:

« Haga clicy mantenga pulsado el valor del pardmetro. A continuacién, arrdstrelo hacia la
izquierda para reducir su valor o hacia la derecha para aumentarlo.

« Hagadlicen el valor del parametro. Aparecerd un campo de texto. Escriba el nuevo valor del
pardmetroy pulse Entrar.

5. En el drea derecha de la vista de linea de tiempo, haga clic en el fotograma en el que desee crear el
segundo fotograma clave de animacidén para el efecto.

ro=al

6. Cree el segundo fotograma clave para la animacidn del efecto realizando una de las siguientes
acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

7. Enla columna Parameters (Parametros), ajuste el valor del pardmetro en el fotograma clave actual.
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8. Repita los pasos para crear tantos fotogramas clave de animacién para el efecto como sea necesario.

9. Para ajustar el tiempo entre los fotogramas clave de la animacidn, seleccione el primer fotograma
clave.

10. Enlabarra de herramientas de linea de tiempo, haga clic en el botén <~ Set Ease for Multiple
Parameters (Definir aceleracién para varios pardmetros).

Aparece el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios
parametros). El grafico de funciones de este cuadro de didlogo se centrard en el primer o fotograma
clave de la animacidn, que debe tener un controlador de la = curva Bézier al lado apuntando hacia la
derecha.

Segundo
fotograma clave

S EEEE@E

Primer
fotograma clave

Controlador de
curva Bézier

I

Apply Appl

11. Haga clicen el controlador de la = curva Bézier y arrdstrelo hacia la derecha, en cualquier angulo,
para ajustar la aceleracién gradual de la animacién.

12. Haga clicen Apply/Next (Aplicar/siguiente).
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El cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios parametros)
se centrard en el segundo fotograma clave. Si este es el Ultimo fotograma clave de la animacidn, solo
tendrd un controlador de curva Bézier apuntando hacia la izquierda. Si hay mds fotogramas clave de
animacion después de este, tendrd dos controladores de la curva Bézier, uno apuntando en cada

direccion.

13. Haga clicen el controlador izquierdo de la - curva Bézier y arrastrelo hacia la izquierda, en cualquier
angulo, para ajustar la desaceleracién gradual de la animacién entre el fotograma clave anterior y el
fotograma clave actual.

14. Sihay un controlador de curva Bézier m apuntando hacia la derecha, haga clicen él y arrdstrelo
hacia la derecha, en cualquier angulo, para ajustar la aceleracién gradual de la animacién entre el
fotograma clave actual y el siguiente fotograma clave.
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15. Repita los pasos anteriores hasta que el tiempo de la animacidn se ajuste a lo largo de toda la escena.

Animacidn de un efecto en el cuadro de didlogo de propiedades de capa

1. Abralas propiedades de capa del efecto realizando una de las siguientes acciones:

o Agregue la vista de propiedades de capa al espacio de trabajo y seleccione el efecto en la
vista de linea de tiempo.

« Enlavista de linea de tiempo, haga doble clic en la capa del efecto, pero no en sunombre.

2. Enlas propiedades de capa del efecto, localice el pardmetro que desea animar y haga clic en el botdn
S Function (Funcidn) situado a su derecha.

El campo de entrada del pardmetro se atenuara. Esto se debe a que no puede editar un pardmetro
directamente una vez conectado a una funcién. El campo indicard el nombre de la funcién que se
cred para él en este formato:

Nombre de capa: Nombre de funcién: Valor en fotograma actual
3. Haga clicde nuevo en el botdn Function (Funcién) del pardmetro.

Se abre el cuadro de didlogo Bezier Editor (Editor de Bézier).
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Cursor de

fotograma actual

-| Grafico de funciones

Este cuadro de didlogo permitird animar la funcidn. El gréfico de funciones de la parte inferior sirve
para representar los valores de la funcién a lo largo de cada fotograma de la escena.

4. En el gréfico de funciones, haga clicy arrastre el cursor rojo ' para moverlo al fotograma donde
desea crear el primer fotograma clave de animacién.

5. Haga clicen el botén ¢ Add Keyframe (Agregar fotograma clave) para crear el primer fotograma

clave de animacidn para el efecto.

Se crea un fotograma clave o y debe ser visible en el gréfico de funciones. Si no se ve, es porque el
gréfico de funciones no estd colocado para incluir el fotograma clave en su fotograma. Para mover el
gréfico de funciones con el fin de ver el fotograma clave de la funcién, haga clic en el botén ©) Reset
View (Restablecer vista) o @ Reset View Vertically (Restablecer vista vertical).
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6. Ajuste el valor del pardmetro al fotograma actual realizando una de las siguientes acciones:

« En el campo Value (Valor) sobre el gréfico de funciones, escriba el valor deseado para el
pardmetro.

« En el gréfico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

:Q’. CONSEJO

Si desea establecer el fotograma clave en un valor que estd fuera del fotograma
del gréfico de funciones, puede pulsar la tecla 1 para alejarse. También puede
pulsar la tecla 2 para volver a acercarse.
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7. Hagaclicy arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo
fotograma clave de animacidn.

8. Hagaclicen el botén o Add Keyframe (Agregar fotograma clave) para crear el segundo fotograma
clave de animacion para el efecto.

9. Ajuste el valor del pardmetro al fotograma actual realizando una de las siguientes acciones:

o En el campo Value (Valor) sobre el gréfico de funciones, escriba el valor deseado para el
pardametro.

« En el gréfico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.
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10. Sidesea ajustar el tiempo de la animacién entre el primer y el segundo fotograma clave, haga lo
siguiente:

« Haga dlicy arrastre el controlador de la = curva Bézier del primer fotograma clave hacia la
derecha, en cualquier direccidn, para que afecte a la aceleracién gradual de la animacién.

« Haga clicy arrastre el controlador de la <= curva Bézier del segundo fotograma clave hacia la
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izquierda, en cualquier direccidn, para que afecte a la desaceleracién gradual de la animacion.

11. Repita estos pasos hasta que haya creado y sincronizado los fotogramas clave de animacién
necesarios para animar el efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra cémo combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguird automaticamente la animacién del personaje, incluso si después cambia la animacion.

Creacion de una sombra paralela para un personaje animado

1. Enlavista de linea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje estd bajo un peg maestro, también funcionarad si selecciona el peg maestro.

rno=am
o
o
o

o
o
o
i)

2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asf, haga clic con el botdn
derecho en la seleccidn vy, a continuacidn, seleccione Group Selection (Agrupar seleccién).
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3. Una vez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la seleccién vy, a continuacidn, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y tiempo).

« En el menu superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

ro=al
L]

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempoy la
misma exposicién que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacién del personaje y la animacién del
personaje clonado se actualizard automaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen +,
Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

« Haga clic con el botén derecho en la seleccidn vy, a continuacidn, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. En lavista de linea de tiempo, seleccione la capa raiz del clon del personaje.

6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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o Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
botén (& Add Peg (Agregar peg).

o Pulse Ctrl + P (Windows/Linux) o 38 + P (macOS).

En la vista de linea de tiempo, seleccione el peg padre del clon.

En la barra de herramientas de herramientas, seleccione la herramienta .} Transform
(Transformar).

En la vista de cdmara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Capitulo 16: Uso de guias de dibujo

Las gufas de dibujo son ayudas para dibujar que puede agregar a su escena para ayudarle a dibujar fondos y
objetos con lineas rectas, angulos rectos y efectos de proyeccién grafica, como la proyeccién isométrica, la
perspectiva recta y la perspectiva curvilinea. En el arte tradicional, esto se realiza con herramientas, como
reglas, reglas T, escuadras y puntos de desaparicién. Las guias permiten simular el uso de dichas herramientas
junto a las herramientas de dibujo en Harmony.

Harmony admite distintos tipos de gufas de dibujo, cada una disefiada para distintos tipos de tareas de dibujo.
La mayoria de las guias de dibujo de Harmony funcionan agregando una linea de horizonte y puntos de
desaparicion a su espacio de dibujo. Cuando utiliza una guia de dibujo, se dibujan lineas de guia de puntos
mediante el cursor del ratdn. Estas lineas de guia son paralelas o perpendiculares a la linea de horizonte, o van
desde uno de los puntos de desaparicidn de la guia hasta el cursor del ratén. Cuando empieza a dibujar un
trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guia, como si dibujara con una
regla. También puede utilizar las guias de dibujo como simples ayudas visuales sin fijar su herramienta de dibujo
a los ejes.

Harmony admite los siguientes tipos de guias de dibujo:

« Lareglale permite colocar y rotar un eje y, a continuacion, dibujar una linea a lo largo de dicho eje, como
una regla normal.

« La cuadricula cuadrada le ayuda a dibujar lineas paralelas o perpendiculares a la linea de horizonte.

=y

« Laguia de perspectiva isométrica le ayuda a dibujar lineas paralelas a uno de los tres ejes: el eje x, el eje
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y,y el eje z. El dngulo de cada eje se puede personalizar seguin sea necesario.

Este tipo de seudoperspectiva, también conocida como proyeccién paralela, a menudo se utiliza en
juegos 2D, infograffas y esquemas para representar objetos y entornos 3D sin utilizar ninguna
perspectiva, escorzo o renderizado 3D real. En la animacién 2D, a menudo se utiliza para dibujar fondos
de paneo largos desde un dngulo alto o bajo.

<>

o

« Laguia de perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un Unico punto de
desaparicion en el centro del horizonte. También le ayuda a dibujar lineas paralelas o perpendiculares a
la linea de horizonte.

Esto es (til para dibujar estructuras de forma de cuboide que se encuentran de cara a la cdmara.

« Laguia de perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
desaparicion, que se colocan en la linea de horizonte fuera del campo de la cdmara. También le ayuda a
dibujar lineas perpendiculares a la linea de horizonte.

Esto es (til para dibujar estructuras de forma de cuboide desde un dngulo horizontal especifico.
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« Laguiade perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los tres puntos de
desaparicidon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de desaparicién en la
Iinea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el eje z. El otro punto de
desaparicion se coloca debajo de la linea de horizonte para ayudarle a dibujar lineas en el eje y.

Esto es (til para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

« Laguia de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar lineas procedentes de uno de los
tres puntos de desaparicion. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de
desaparicion en la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x o en el gje
z. El otro punto de desaparicidn se coloca encima de la linea de horizonte para ayudarle a dibujar lineas
en el ejey.

Esto es (til para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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« Laguia de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panoramicos
horizontales, con lineas horizontales curvilineas. Un punto de desaparicidon se coloca en el centro de la
Iinea de horizonte, para ayudarle a dibujar lineas en el eje z, y dos puntos de desaparicidn se colocan en
la linea de horizonte fuera del campo de la cdmara, para definir la curva de las lineas horizontales. Las
Iineas verticales se colocan perpendicularmente a la linea de horizonte.

Esto es dtil para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la cdmara
sobre el fondo dibujado con una gufa de perspectiva con 3 puntos (paneo horizontal) simulard una

rotacién de la cdmara en el eje y.

]

e : .
__/

« Laguiade perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panordmicos verticales,
con lineas verticales curvilineas. Un punto de desaparicidn se coloca en el centro de la linea de horizonte,
para ayudarle a dibujar lineas en el eje z, y dos puntos de desaparicion se colocan debajo de la linea de
horizonte, fuera del campo de la cdmara, para definir la curva de las lineas verticales. Las lineas

horizontales se colocan paralelamente a la linea de horizonte.

Esto es (til para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la cdmara sobre
el fondo dibujado con una guia de perspectiva con 3 puntos (paneo vertical) simularad una rotacién

vertical de la cdmara en el eje X.
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« Laguia de perspectiva continua con 4 puntos es muy parecida a la gufa de perspectiva con 3 puntos
(paneo horizontal), salvo que estd disefiada para ayudarle a dibujar fondos panordmicos completos de
360°.

Esta gufa utiliza 5 puntos de desaparicién. Cuando dibuja una linea horizontal, se curva formando un arco
sobre uno de los puntos de desaparicidn y llegando hasta los dos puntos de desaparicién circundantes.
Esto crea un efecto de perspectiva donde cada punto de desaparicidn representa uno de los puntos
cardinales, salvo los puntos mas a la izquierda y mds a la derecha que representan el mismo punto
cardinal, lo que crea un fondo en bucle. Los fondos creados con la gufa de perspectiva continua con 4
puntos se pueden repetir en bucle horizontalmente para simular una rotacién completa de la cdmara en
el ejey.

Sur | @ Norte Oeste Sur

« Laguia de perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la gufa de perspectiva
con 2 puntos, salvo que sus lineas verticales son curvilineas, para que se puede utilizar para crear fondos
de paneo verticales. Dos puntos de desaparicidon se encuentran en la linea de horizonte, fuera del campo
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de la cdmara, para ayudarle a dibujar lineas en el eje x y el gje z, y dos puntos de desaparicién se colocan
encima y debajo del campo de la cdmara para definir la curva de las lineas verticales.

Esto es (til para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de
cuboide se ven desde un dngulo.

« Laguia de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilineos en el eje x y en el
eje y. Tiene un punto de desaparicién central en la linea de horizonte, desde el que se dibujan lineas en el
eje z; dos puntos de desaparicion en los extremos de su linea de horizonte, para definir la curva de lineas

horizontales; y dos puntos de desaparicién encima y debajo de la linea de horizonte, para definir la curva
de las lineas verticales.

Esta guia se puede utilizar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo de
pez. También se puede utilizar para dibujar fondos que se deben recorrer en varias direcciones.
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Para usar una gufa de dibujo, en primer lugar debe agregarla a la lista de gufas de la escena. Para familiarizarse
con las guias, puede comenzar agregando la guia de dibujo de perspectiva con 1 punto a la lista de guias.

Adicién de una guia de dibujo de perspectiva con 1 punto a la escena

1. En labarra de herramientas de herramientas, seleccione Herramienta & Pincel, # Lapiz, (- Linea
vectorial transparente o / Linea Herramienta.

NOTA

Las guias de dibujo solo estdn visibles en la vista de cdmara o de dibujo cuando estd
seleccionada una de las herramientas.

2. Agregue la vista de guias a su espacio de trabajo realizando una de las siguientes acciones:

« Enlaesquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botén ==
Add View (Agregar vista) y seleccione Guides (Gufas).

« En el menu superior, seleccione Windows > Guides (Ventanas > Gufas).

3. Enlavista de guias, haga clic en el botdn + New Guide (Nueva guia) y seleccione {} 1-Point
Perspective (Perspectiva con 1 punto).

La nueva gufa aparece en la lista de guias.
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Mumber of Lines

Cuando se agrega una gufa nueva, su linea de horizonte se configura en una posicién y un dngulo predefinidos y
sus puntos de desaparicidn se configuran en una posicién predefinida. En muchos casos, debe realizar ajustes
en la gufa para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guia de perspectiva con 1 punto en una

1. En la barrade herramientas de herramientas, seleccione Herramienta & Pincel, # Lépiz, (- Linea
vectorial transparente o / Linea Herramienta.

NOTA

Las guias de dibujo solo estdn visibles en la vista de cdmara o de dibujo cuando esta
seleccionada una de las herramientas.

2. Enlavista de gufas, aseglrese de que la opcién Enable Guides (Habilitar gufas) 4 esté activada.

3. Enlalista de gufas, seleccione la gufa de < perspectiva con 1 punto en una en la que desee realizar
ajustes.

La guia seleccionada aparece en la vista de cdmara o de dibujo.

Linea de horizonte I

l

I Punto de desaparicién
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4. Realice una de las siguientes acciones:

« Para cambiar la gufa de posicion sin rotarla, haga clicy arrastre su punto de desaparicién @.

« Pararotar la guia, haga clicy arrastre su linea de horizonte.

CONSEJOS

o Cuando el ratdn se coloca encima de la linea de horizonte, el cursor del ratdn
cambiard a 7 para indicar que est3 a punto de rotar la gufa.

« Puede mantener pulsada la tecla Mayds para que el dngulo de la guia se ajuste
al multiplo de 15° mas cercano.

« Puede mantener pulsada la tecla Alt para que la guia rote alrededor del centro
de los dos controladores de rotacion.

« Alrotar una guia, sudngulo se muestra en la esquina superior izquierda de la
vista de cdmara o de dibujo.

5. Unavez que haya terminado de realizar ajustes en la gufa, puede hacer clic en el botdn [=a
Lock Guides (Bloquear guias) en la vista de guias para evitar modificar su guia accidentalmente
mientras dibuja.

Una vez que la guia esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

CONSEJO

De forma predeterminada, la opcién Align with Guide (Alinear con guia) ~#" de la vista de guias estd
habilitada. Cuando esta opcién estd habilitada mientras dibuja con una guia, la herramienta de
dibujo se fijard automdaticamente en el eje que coincida mas exactamente con el angulo del trazo,
como si dibujara con una regla. Puede deshabilitar esta opcidn si desea dibujar una perspectiva a
mano alzada.

Dibujo con guias de dibujo

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacfia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

e Pulse Alt + Mayus + R

2. Enlabarra de herramientas de herramientas, seleccione Herramienta & Pincel, # Ldpiz, (- Linea
vectorial transparente o / Linea Herramienta.
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NOTA

Las guias de dibujo solo estdn visibles en la vista de cdmara o de dibujo cuando esta
seleccionada una de las herramientas.

3. Enlavista de guias, seleccione la guia que desee usar.

4. Pare evitar editar su guia accidentalmente mientras dibuja, haga clic en el botén Lock Guides
(Bloquear gufas) en la vista de guias para activarla.

5. Sidesea bloguear sus trazos con los ejes de la gufa, asegurese de que la opcién ~" Align with Guide
(Alinear con guia) esté activa. En caso contrario, desactivela para poder dibujar libremente y use solo
las guias como referencias.

6. Mueva el cursor del ratén alrededor del espacio de dibujo. Observe que las lineas de gufas pasan por
el cursor del ratdn, una por cada uno de los ejes de la guia de dibujo.

7. Comience a dibujar en trazo en el mismo dngulo que uno de los ejes.

Sila opcién ~#" Align with Guide (Alinear con guia) estd habilitada, el trazo se alinea con el eje mas
cercano a su angulo, como si dibujara con una regla.
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CONSEJO

También puede seleccionar el eje al que desee fijar el trazo pulsando las teclas Flecha izquierda
y Flecha derecha para pasar por cada eje. El eje seleccionado aparecerd mas resaltado que los
demds. Si pasa por todos los ejes, ningun eje estard resaltado, lo que significa que el eje al que
se fija la herramienta de dibujo se vuelve a determinar en funcién del dngulo de su trazo.

Una vez que haya terminado de trabajar con las guias, puede deshabilitarlas. Cuando las guias de dibujo estan
deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de
dibujo.

Habilitaciéon y deshabilitacion de guias de dibujo

1. Para habilitar o deshabilitar las gufas de dibujo, realice una de las siguientes acciones:
o En lavista de guias, haga clicen el botdn Enable Guide (Habilitar gufa).

o Pulse Mayls + G.

NOTAS

« Las guias se habilitan automaticamente al agregar una nueva guia o al seleccionar una guia
en lalista de guras.

« Laguia que selecciond al deshabilitar las guias se volvera a seleccionar cuando vuelva a
habilitar las gufas.

« Las gufas de dibujo solo funcionan con las herramientas Herramientas & Pincel, # Lépiz,
~ Linea vectorial transparentey / Linea Herramientas. Si se selecciona cualquier otra
herramienta, las gufas de dibujo se comportaran como si estuvieran deshabilitadas.
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Capitulo 17: Creaciéon de un multiplano

En la accidn en vivo, cuando la cdmara se mueve alrededor de una escena, parecerd que los objetos cercanos a la
camara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacién 2D, se puede

conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje Z para agregar profundidad y moviendo la cdmara por el entorno resultante para crear una ilusién de

perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada una representa un objeto que se
encuentra a una distancia diferente de la cdmara. A la izquierda, puede ver cémo se sitda cada objeto en
relacién con la cdmara, como si estuviera mirdndolos desde un lado. A la derecha, puede ver cémo se sitdan las
capas en relacién entre si como si estuviera mirando la escena desde una esquina. A continuacién, puede ver la
escena desde el punto de vista de la cdmara.
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Mediante la herramienta Maintain Size (Mantener tamafo), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la cdmara mientras
se ajusta automdticamente el tamafio de la capa proporcionalmente a su distancia de la cdmara, conservando su
tamafo aparente desde el punto de vista de la cdmara. Por lo tanto, no tiene que preocuparse por el tamafio y
la posicidn de las capas al disefiar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacion para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamaio)

1. Aseglrese de que la opcién No Z Dragging (Sin arrastre de eje z) del menu superior Animation
(Animacidn) esté deshabilitada.

2. Realice una de las siguientes acciones:

o En labarra de herramientas de animacién avanzada, seleccione la herramienta 50
Maintain Size (Mantener tamano).

« En el menu superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamano).
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o Pulse Alt + 6.

3. Enlavista lateral o superior, seleccione una de las capas de la seccién de imdgenes en miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cdmara.

El elemento se moverd en el eje Z de la escena, pero mantendrd el mismo tamafio aparente en la
vista de cdmara.

Puede ver el multiplano desde distintos puntos de vista mediante la vista de perspectiva.

Visualizacién del multiplano en la vista de perspectiva

1. Habilite la vista de perspectiva realizando una de las siguientes acciones:

« Hagaclicen el botén Add view (Agregar vista) situado junto a las pestanas de las
vistas de cdmara y de dibujo y seleccione Perspective (Perspectiva).

o En el menu superior, seleccione Windows > Perspective (Ventanas > Perspectiva).

2. Pararotar la vista de perspectiva en las 3 dimensiones, mantenga pulsado Ctrl + Mayus
(Windows/Linux) o & + mayusculas (macOS) y, a continuacidn, haga clicy arrastre.
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Capitulo 18: Creacion y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en la vista de linea de tiempo.

Creacion de una plantilla

Creacién de una plantilla

1. Enlavista de linea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser Util para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. Enlavistade libreria, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendrd una libreria denominada Libreria de Harmony Advanced almacenada en el ordenador, en la
subcarpeta Librerfa de Toon Boom Harmony Advanced de la carpeta Documentos.

3. Sila carpeta de libreria estd blogueada, haga clic con el botén derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre la seleccidn a la carpeta de la librerfa elegida.

Library  ==[%

[ATTWI]

[ AW ]

Timeline

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Haga clicen OK (Aceptar).
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_‘Q'. CONSEJO

Para cambiar el nombre de una plantilla una vez creada, haga clic con el botén derecho sobre ellay
seleccione Rename (Cambiar nombre).

Importacion de una plantilla

Importaciéon de una plantilla

1. En lavista de librerfa, seleccione la plantilla que desea importar.

2. Arrastre la plantilla seleccionada a la vista de cdmara o a la izquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdmara, sus capas se agregardn en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertard entre las
capas en las que la colocd.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de insertar
nuevas capas en la escena, esta accién reemplazara los dibujos y los fotogramas clave de la escena
por los de la plantilla. Esto es Util para importar plantillas de pose o animacién para los personajes
gue ya se encuentran en la escena.
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Library | =%

[ATWI]

Timeline  ==[%

+ %

K
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Capitulo 19: Exportacion de una pelicula

A través del cuadro de didlogo Export Movie (Exportar pelicula), puede exportar la animacién como un archivo
de video. Harmony exportard toda la escena en su resolucién completa de forma predeterminada. Silo prefiere,
puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo en una resolucién mas
pequenfia, lo cual puede ser Util si necesita ahorrar tiempo o espacio en disco. En funcién del formato en el que
exporte la pelicula, también puede personalizar los ajustes de compresién de video y de audio para mds calidad
o para obtener espacio en disco.

Exportacion de un archivo de pelicula

1. En el mend superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

2. Enla seccién Output (Salida), abra el mend desplegable Video Format (Formato de video) y
seleccione el formato deseado para su archivo de pelicula:

o QuickTime Movie (*.mov): para exportar un archivo en formato Apple QuickTime. Este
es el formato de exportacién predeterminado que se recomienda por su portabilidad y
porque le permite elegir entre varios cédecs de video.
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NOTAS

o« En Windows, se debe instalar QuickTime de Apple para que Harmony
pueda exportar peliculas de QuickTime. Puede configurar que las
peliculas de QuickTime utilicen cualquier cédec compatible con
QuickTime, incluidos H.264, MPEG-4 y Animation, para su exportacion.

o« En macOS, Harmony utiliza Apple AVFoundation para exportar
peliculas de QuickTime, lo que le permite utilizar cédecs como H.264,
Apple ProRes 422 y Apple ProRes 4444,

« En GNU/Linux, Harmony utiliza la libreria OpenQuickTime para
exportar las peliculas de QuickTime. Esto solo le permite exportar
videos en formatos comunes, como M-JPEG, JPEG para fotos, PNG o

RGB sin comprimir.

o H.264/MPEG-4 (*.mp4): un formato de pelicula sencillo que utiliza el cédec H.264
compatible con la mayoria de navegadores web.

NOTAS
o Las peliculas que se exportan desde Harmony en formato .mp4 no

tienen audio.

« Siesla primeravez que exporta una pelicula en formato .mp4, se le
solicitard que descargue la librerfa OpenH264 de Cisco. Simplemente
haga clicen Yes (Sf) cuando se le solicite, y Harmony descargard la
libreria automdaticamente vy, a continuacidn, exportara la pelicula.

« No hay opciones de codificacién para archivos .mp4.

« Windows Media Video (*.wmv): este formato estd disponible como alternativa para
los usuarios de Windows que no deseen instalar Apple QuickTime en su estacidn de

trabajo Windows.

NOTAS

o Los archivos Windows Media Video (.wmv) solo se pueden exportar en

Windows.

« Losreproductores de video y editores en sistemas que no sean de
Windows normalmente no pueden abrir archivos Windows Media

Video (.wmv).
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3. Hagaclicen el botén Browse (Examinar).

4. En el cuadro de didlogo Save (Guardar) que aparece, examine la ubicacién en la que desee exportar
el archivo de pelicula.

5. En el campo File name (Nombre de archivo), escriba el nombre del archivo que desee darle al archivo
de pelicula.

6. Hagaclicen Save (Guardar).
7. Enlaseccidn Export Range (Rango de exportacidn), realice una de las siguientes acciones:
o Seleccione All (Todo) si desea renderizar la escena entera.

« Seleccione Frames (Fotogramas) si desea renderizar una parte de la escena. A continuacion,
en el campo de la derecha, introduzca el primer fotograma de la secuencia que desea
exportar, y en el otro campo, el Ultimo fotograma de la secuencia que desea renderizar.

8. Abra lalista desplegable Resolution (Resolucidn) y realice una de las siguientes acciones:

« Seleccione Same as Scene Resolution (Igual que resolucién de escena) si desea exportar una
pelicula con la misma resolucién que la escena.

« Seleccione 3/4 of Scene Resolution (3/4 de resolucién de escena), 1/2 of Scene Resolution
(1/2 de resolucién de escena), 1/3 of Scene Resolution (1/3 de resolucién de escena) o 1/4 of
Scene Resolution (1/4 de resolucién de escena) si desea exportar una pelicula que sea inferior
a la resolucién de la escena.

« Seleccione Custom (Personalizado) si desea establecer la resolucion de exportacién
manualmente. A continuacidn, en los campos Width (Ancho) y Height (Altura), introduzca en
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pixeles la resolucién deseada para su pelicula.

9. Hagaclicen OK (Aceptar).

10. En el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clicen
OK (Aceptar).

Aparece una barra de progreso.

11. Desplacese a la ubicacién en el ordenador en la que ha exportado el archivo de pelicula y haga doble
clicen él para verlo en el reproductor de video.
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Glosario

3D
estereoscépico

aberracién
cromadtica

aceleracién

aceleracién de
entrada

aceleracién de
salida

aceleracién
gradual

alimentador de

papel
automatico

animacién

animacién Cut-
out

Imdgenes o peliculas que generan dos imagenes diferentes, cada uno desde el
punto de vista de uno de los ojos humanos. Cuando se visualizan o proyectan a
través de dispositivos especiales, como una pantalla 3D o gafas de realidad
virtual, se crea la ilusién que los elementos de la imagen se encuentran enfrente
del espectador.

En Jdptica, una aberracidén cromdtica (CA), acromatismo o distorsién cromatica, es
un tipo de distorsidn en el que una lente no puede enfocar todos los colores en el
mismo punto de convergencia.

En animacidn, la velocidad es la aceleracidn y la desaceleraciéon de un movimiento.
Puede ser un movimiento creado mediante una curva de funcién o una serie de
dibujos animados. Otros términos comunes para aceleracién gradual y
desaceleracién gradual son aceleracién y desaceleracion.

Aceleracién drastica al principio de la accién.

Aceleracién drdstica al final de la accién.

Aceleracién gradual en la accién. Conocida también como aceleracién.

Método automatizado de introducir dibujos en un escéner en el que hay varios
dibujos apilados en un alimentador de hojas. Cuando se activa el escéner, los
dibujos se digitalizan de forma consecutiva, sin ninguna otra intervencién del
usuario.

Simulacién de movimiento que se crea dibujando o editando fotogramas
individuales.

El proceso conocido como animacion Cut-out es la accidn de animar personajes
compuestos por varias piezas moviéndolos de fotograma en fotograma. La
animacion Cut-out se puede generar por ordenador o realizarse del modo
tradicional utilizando papel.
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animacion
directa

animacion pose
a pose

animacion
secundaria

animacion sin

papel

animacion

tradicional

animatica

anime

arco

arrastrar

Técnica en la cual se dibuja por orden una secuencia completa desde la primera
posicidn hasta la Ultima. Esta metodologia requiere muy poca planificacion. El
lugar en el que el personaje termina y cémo llega hasta alli pueden ser una
sorpresa tanto para el publico como para el animador. Este enfoque es
espontdneo y creativo, pero puede generar resultados imprecisos.

El proceso de animacidn pose a pose es la accién que consiste en crear todas las
poses de accidn principales, denominadas poses clave, y después colocar las
poses secundarias entre las claves. Las poses secundarias se denominan
descomposicién. Por Ultimo, el animador rellena los huecos con los dibujos
intercalados para lograr una animacién fluida.

Movimiento secundario provocado por la accidn principal. Por ejemplo, un
personaje que corre y lleva puesta una capa. La accién principal es el cuerpo que
corre. Esto provocara que la capa siga el movimiento, aunque no se mover3 al
mismo tiempo, sino que reaccionarad varios fotogramas después y seguird la curva
de movimiento principal.

El proceso de animacién sin papel es la accidon de animar digitalmente. El principal
proceso de animacion sin papel es dibujar la animacién, fotograma a fotograma,
directamente en el software.

Tipo de proceso de animacién mediante el cual todas las secuencias de animacion
se dibujan a mano en papel antes de digitalizarlos o tintarlos en celdas.

Una pelicula hecha con secuenciacidn de paneles en un storyboard, en la que se
establece el tiempo aproximado de cada panel para la accién que representa y se
sincroniza cada panel con la pista de sonido. Las animaticas se utilizan para
convertir el storyboard en un borrador de la pelicula final con el fin de determinar
el tiempo asignado a cada escena y a cada accidn y sincronizar la accién con la
pista de sonido.

Animacidn japonesa.

La accidn no suele producirse de forma directa, sino que mas bien se suele
desplegar en lo que los narradores denominan un arco. El propdsito de un arco de
historia es mover un personaje o situacién de un estado o escenario al siguiente.

Operacidn gque consiste en hacer clic en un elemento, mantenerlo pulsadoy, a
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artista de layout

atajos de
teclado

baja resolucién

bocetos

campo

canal alfa

capa

capade fondo

capa superior

carta de color

continuacién, moverlo mediante el movimiento del cursor del ratén. Esto se puede
realizar con el botdn izquierdo del ratén o con la punta del Ipiz.

Artista que dibuja el fondo y crea la cdmara y la gufa de campo, haciendo coincidir
la escena y el movimiento de la cdmara. Dibujara en el modelo las poses de accidn
principales.

Tecla de teclado o combinacidn de teclas de teclado que se asigna para realizar
un comando especifico en la aplicacidn al pulsarlos.

Formato idéneo para videos destinados a la web, donde el tamafio y la descarga
rapida del archivo de video tienen prioridad respecto a la calidad. Una imagen de
baja resolucidn es aguella que no contiene detalles precisos.

Es un nombre comun en una pelicula de animacién para un dibujo que se utiliza
como referencia, pero no forma parte de la imagen final. Un layout es un boceto.
Es el esbozo del esqueleto de una animacién o disefo. Los bocetos consisten
principalmente en lineas y formas esbozadas, pero también pueden contener
detalles de diseno.

Unidad de medida que se utiliza en la animacidn tradicional para registrar y
realizar un seguimiento de la cdmara, asi como de su proximidad a la escena.

Canal de imagen que contiene informacién de transparencia. De partida, una
imagen tiene tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal
(A). El mate, o informacién de transparencia, se almacena en este cuarto canal.
Una imagen sin canal alfa siempre es opaca.

En animacidn, una capa es una columna, nivel o personaje individual. Las capas de
una escena estan superpuestas para formar la imagen final.

En animacidn, una capa de fondo es una parte especifica de la decoracién
colocada detrds de la animacién principal.

Parte del entorno de una escena, como una silla o un arbusto, que se coloca
delante de la animacién principal.

Una carta de color es una tarjeta que contiene un color sélido con el mismo
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cartade
exposicién

cartade
fonemas

carta de rodaje

celda

ciclo

ciclo de andar

cinematica
directa

tamano que la cdmara. La carta de color rellena el fondo con un color sélido
cuando no se ha incluido ninguna imagen de fondo.

Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para
indicar el tiempo de una escena. Cada columna representa una capa de escena.
Los numeros de dibujos de cada columna se indican y se repiten alolargo de |a
cantidad de fotogramas determinada en la que deben aparecer. La carta de
exposicion la utilizan los animadores, directores y otros miembros del equipo para
trazar la secuencia y el tiempo de las imdgenes, el didlogo, los efectos de sonido,
las pistas de sonido y los movimientos de cdmara. Conocida también como carta
de rodaje.

Carta basada en los ocho fonemas de la animacién (A, B, C,D, E,F, Gy X, que se
utiliza para representar el silencio) utilizados para la sincronizacién de labios.

La utilizan los animadores, directores y otros miembros del equipo para trazar la
secuencia y el tiempo de las imdgenes, el didlogo, los efectos de sonido, las pistas
de sonido y los movimientos de cdmara. Conocida también como carta de
exposicion.

En la animacidn tradicional, una celda (también denominada celuloide) es una
hoja transparente en la que la animacidn se tinta y se pinta antes de enviarla ala
cdmara. El trazado de la imagen se dibuja en la parte delantera de la celday, a
continuacidn, se colorea por la parte trasera.

Serie de fotogramas de animacién gque se pueden repetir para simular un
movimiento continuo. Por ejemplo, un personaje a menudo camina mediante una
animacion en la que da dos pasos, uno con cada pie y, a continuacion, repitiendo
la animacidn.

Serie de dibujos “en el lugar” que describen cémo camina un personaje. La ilusién
de movimiento se crea utilizando paneos de fondo. Para evitar realizar
innumerables dibujos, los animadores suelen realizar un ciclo de andar para un
personaje.

La cinematica directa es una funcidn utilizada para animar principalmente
personajes 3D y marionetas Cut-out con jerarqufa. Se utiliza para animar una
marioneta a partir de una de sus partes padres, como un hombro, y hacer que el
resto del brazo se mueva con ella como un todo.
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cinematica
inversa (1K)

circulo
cromatico

clean up

CMYK

cddigo de

tiempo

composicién

corte

corte de salto

cuadro de texto

Funcidn utilizada principalmente para animar personajes 3D y marionetas Cut-
out con jerarquia. La cinematica inversa animard una marioneta desde una de las
extremidades, como una mano, y permitird que el resto del cuerpo la siga con
naturalidad.

Visualizacidn del espectro de colores en forma de circulo.

Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de la
imagen (lineas sobrantes, notas, etc.) para crear dibujos finales que se pueden
tintar, pintar y filmar. El proceso de clean up hace referencia al trazado de una
Iinea limpia sobre un boceto para conseguir la versidn final o a la eliminacién de la
suciedad vy las lineas adicionales que han quedado tras el proceso de
digitalizacién.

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el
modelo estdndar utilizado en un proceso denominado impresion offset.

Informacidn de tiempo impresa en un clip de pelicula para indicar la escena, hora,
minuto y segundo que se muestran actualmente en pantalla.

La composicién es la accién de incorporar todos los elementos de una escena para
crear el resultado final antes del renderizado. Por ejemplo, el artista de la
composicién importara todas las secuencias, el fondo, las superposicionesy las
subcapas de la animacidn en la escena y los colocard correctamente. A
continuacion, el artista definird el encuadre de cdmara y lo animara en caso
necesario. Por Ultimo, el animador creard todos los efectos generados por
ordenador para el proyecto.

Cuando una escena pasa a la escena siguiente de un fotograma a otro sin ningun
efecto visual.

Corte brusco entre dos escenas. Normalmente, un corte de salto no es
visualmente agradable. Normalmente lo provoca el final de una escenay el
comienzo de otra, con una imagen parecida. La falta de diferencia provoca que el
0jo vea un pequeno salto entre las dos escenas.

Campo de texto que contiene informacién de didlogo, efectos, sonido o slugging
en un storyboard.
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curva Bézier

depuracion de
sonido

desaceleracién

desaceleracién
gradual

descomposicién

desglose de
pista de audio

desplazamiento
pequeio

deteccién
automatica de
sincronizacién
de labios

Método para definir lineas curvas inventado por el matemético francés Pierre
Bézier. Una curva Bézier es una curva matemadtica o paramétrica. Los puntos de
control definen las curvas Bézier. En Harmony, las curvas Bézier tienen un punto
de inicio, un punto de final y dos puntos de control interiores que influyen la curva
entre los puntos de inicio y final.

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el
cabezal de reproduccién hacia delante o hacia atras. Es muy (til para realizar el
ajuste preciso de una sincronizacién de labios.

Desaceleracién gradual en la accién. Conocida también como desaceleracién
gradual.

Desaceleracién gradual en la accién. Conocida también como desaceleracidn.

En animacidon Cut-out, la descomposicién es la accién de descomponer un
personaje en trozos para crear una marioneta con articulaciones. Para
descomponer un personaje, el artista corta partes, como las manos vy los brazos,
del modelo del personaje y las pega en capas independientes. A continuacidn, las
articulaciones se fijan y se definen los pivotes. En la animacidn tradicional, una
descomposicidn es una pose de animacién que normalmente se encuentra entre
dos poses clave. Las poses clave son las poses principales de una animacién y las
descomposiciones son poses secundarias que ayudan a describir el movimientoy
la curva de rotacidon (normalmente denominada arco).

Desglose de una pista de pelicula animada en sonidos individuales para generar
la posicién fotograma a fotograma precisa de cada sonido.

Pequefio empujén (izquierda, derecha, arriba, abajo, hacia delante o hacia atrds)
realizado con las teclas de flecha del teclado en un elemento seleccionado. El
desplazamiento pequefio se utiliza para mover una selecciéon de manera muy
ligeray precisa.

Asignacion automética de dibujos en un elemento a la carta de fonemas
generada para un sonido. Puede ahorrar tiempo al sincronizar los labios una pista
de voz.
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deteccién
manual de
sincronizaciéon
de labios

didlogo

diseio del

personaje

dpi

eje

escena

estilo de paleta

exposicién

film-1.33

film-1.66

Intercambio manual de dibujos de posicidén de la boca para que coincidan con una
pista de voz. Para este proceso, se utilizan tanto la depuracién de sonido
(escuchar una onda de sonido descompuesta fotograma a fotograma) como las
sustituciones de dibujos.

Texto hablado por un personaje en una pelicula o animacion.

Cada personaje de una pelicula animada se dibuja desde varios dngulos en
formato de estilo pdster denominado hoja de modelo, que sirve como referencia
para los animadores.

Siglas en inglés para puntos por pulgada, que representa la medida estandar de
resolucion para impresoras computerizadas. En ocasiones se aplica a pantallas, en
cuyo caso es mas exacto denominarlo pixeles por pulgada. En cualquier caso, el
punto es el elemento diferenciado mds pequefio que forma la imagen.

Linea imaginaria alrededor de la cual rota un objeto. Para gréficos 2D, hay dos
ejes: X (horizontal) e Y (vertical). Para gréficos 3D, hay tres ejes: X (horizontal), Y
(vertical) y Z (profundidad). En animaciones que rotan constantemente, el
elemento de eje especifica alrededor de qué eje rota el objeto. Un ndmero
negativo provoca que una animacién rote en sentido contrario a las agujas del
reloj, mientras que un ndmero positivo hace que una animacion rote a la derecha.

Plano en una pelicula o programa. Una secuencia estd compuesta por varias
escenas. Una escena cambia a otra mediante un corte simple o por transicién.

Un estilo de paleta es una segunda version de una paleta existente con un ligero
cambio en el tinte y el valor. Un estilo de paleta se puede utilizar para crear la
version nocturna de una paleta. También se le puede denominar paleta de
clonado.

En animacidn, una exposicion es el nimero de celdas en las que un dibujo aparece
en la escena. Para que un dibujo parezca mas grande, la exposicion se debe
ampliar durante un ndmero de celdas mayor.

Resolucidn idénea para el formato de pelicula panordmico que se ajusta a la
proporcién estandar de 4:3 pixeles.

Resolucién iddnea para el formato de pelicula panordmico que se ajusta a la
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flipping

fondo

fonema

fotograma

fotograma clave

fotograma clave
de movimiento

fotograma clave
de Stop-motion

fotogramas por
segundo

funcidn

proporcién de 16:9 pixeles.

En la animacidn tradicional, flipping es la accién de pasar por los dibujos de una
secuencia de animacién muy rdpidamente con el fin de ver la animacién en
movimiento. Flipping también puede ser la accién de crear una transformacién en
espejo de un objeto.

llustraciones que llenan el campo de la cdmara y que se encuentran detrds de los
personajes y props. Normalmente, estas ilustraciones representan la decoracién o
escena en la que ocurre la accidn.

Unidad de sonido de un idioma.

Un fotograma de animacién es una imagen fotografica Unica en una pelicula. En la
animacion tradicional, el estdndar norteamericano contiene generalmente 24
fotogramas por segundo, mientras que el estdndar europeo es de 25.

Posiciones importantes en la accién que definen los puntos inicial y final de
cualquier accién. Un fotograma clave es una posicién generada por ordenador en
un momento especifico (fotograma) y en una trayectoria determinada.

Fotograma clave con interpolacién generada por ordenador.

Fotograma clave sin interpolacién generada por ordenador.

Representan la velocidad a la que se reproducen los fotogramas por segundo. Se
calculan por lo general en fotogramas por segundo. Por ejemplo, una escena se
podria reproducir a 12, 24, 25, 30 0 60 fotogramas por segundo o a cualquier otro
numero. Es la medida de la frecuencia (tasa) a la que un dispositivo de imagen
produce imagenes consecutivas Unicas, denominadas fotogramas. El término se
aplica por igual a los gréficos por ordenador, videocamaras, camaras de pelicula y
sistemas de captura de movimiento. La tasa de fotogramas se suele expresar
principalmente en fotogramas por segundo (fps) y en monitores de barrido
progresivo en hercios (Hz).

Movimiento, trayectoria o ruta generados por ordenador al que se pueden
conectar pardmetros de elementos, otras trayectorias y efectos. La funcién se
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fundido de

entrada/fundido

de salida

fundido
encadenado

gama

guion

HDTV

hoja de campos

hold

HSV

imagen en

miniatura

ink and paint

puede controlar agregando fotogramas clave y puntos de control en la curva de
funcidn.

El fundido de entrada o fundido de salida es un efecto de transicién utilizado para
abrir o cerrar una secuencia. Un fundido de entrada se produce cuando la primera
escena aparece progresivamente, desde una transparencia total a su opacidad
total. Un fundido de salida se produce cuando la escena desaparece
progresivamente, desde la opacidad total a la transparencia total.

Cuando una escena pasa a la escena siguiente mediante un fundido en el que
desaparece unay aparece la siguiente.

Rango de colores que puede representar un dispositivo determinado.

Texto original que contiene la informacién de toda la pelicula o el programa. En
animacion, el guion contiene todas las descripciones de la ubicacién, el didlogo, el
tiempo, etc. Un proyecto comienza con un guion.

Acrénimo en inglés de television de alta definicidn, que es el estdndar de
resolucién actual para producciones televisivas. La resolucién de producciones de
HDTV es 1280x720 (HD ready) o 1920x1080 (full HD), y sus fotogramas por
segundo normalmente oscilan entre 23.976 y 30.

Guia gque contiene todas las unidades de campo que los artistas de animacién y
layout utilizan para definir el tamafio del campo de la cdmara, asi como sus
movimientos.

Fotograma en la animacion en el cual el personaje mantiene su posicion sin
moverse. Se puede crear un hold entre dos fotogramas clave cualesquiera.

Siglas en inglés para matiz, saturacién y valor. Método para definir los colores en
cuanto a matiz (tinte), saturacién (sombra) y valor (tono o luminancia).

Imagen muy pequena utilizada como una referencia o indicador.

El proceso ink and paint es la accién de pintar las zonas vacias y colorear las
lineas en los dibujos de animacidn finales siguiendo un modelo de color.
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intercalado

interpolacién

layout

layout y pose

libreria

linea de accién

linea de tiempo

lineas
vectoriales
transparentes

mapa de bits

mesa de disco

Dibujos que existen entre las poses clave. Se dibujan para crear transiciones
fluidas entre poses.

Movimiento generado por ordenador creado entre dos fotogramas clave. Se
puede crear interpolacidn, o no, entre los fotogramas clave.

Paso de comunicacidn entre el storyboard y la animacidn. Es la accién de poner el
storyboard en el modelo. Es decir, el personaje se dibuja siguiendo el disefio del
paquete de modelo, de modo que el animador puede comenzar a trabajar. El
artista de layout dibuja el fondo y crea la cdmara y la guia de campo, haciendo
coincidir la escena y el movimiento de la cdmara. Por dltimo, el animador dibuja en
el modelo las poses de accidn principales.

Accidén que consiste en poner el storyboard en el modelo (a la escala adecuada)
para gue el animador comience a trabajar.

Zona de almacenamiento que contiene plantillas y recursos que se pueden
reutilizar en un proyecto o escena.

Linea central en una pose de accién. Cuando se pintan poses de accién sin tocar
la linea de accidn se garantiza que la pose sea dindmica y que su silueta se ajuste
a la direccién de la accién.

Representacidn horizontal de los elementos, el tiempo y los fotogramas clave de
una escena.

Cuando no hacen referencia a trazos reales, las lineas vectoriales transparentes
son contornos invisibles que se utilizan para definir zonas de color o para cerrar
zonas de color abiertas.

Imagen definida por una malla de pixeles, asi como por el color individual de cada
uno de sus pixeles. Los gréficos de mapas de bits se caracterizan por ser
preferibles a los gréficos vectoriales para ilustraciones muy detalladas o
fotorrealistas. Sin embargo, los gréficos de mapas de bits no se pueden escalar,
rotar o sesgar sin que la imagen pierda calidad.

Equivalente al disco/mesa de animacidn, es un dispositivo que permite rotar el
espacio de trabajo para mayor comodidad mientras se dibuja.
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mesa de luz

modelo de color

modelo/modelo

de color

morphing

multiplano

NTSC

PAL

paleta maestra

paleta/paleta
maestra

Dispositivo que permite ver otras capas en transparencia mientras trabaja en una
capa determinada.

Disefio de color oficial que se debe utilizar para pintar la animacién. Un modelo es
el disefio de personaje, prop o ubicacién definitivo que cada artista debe seguir
para la produccidn.

Disefio de personaje, prop o ubicacién definitivo que cada artista debe seguir
para una produccién. Un modelo de color es el disefio de color oficial que se debe
utilizar para pintar la animacidn.

Funcidn que permite crear dibujos generados por ordenador entre un dibujo de
origen y otro de destino. La animacidn creada con la funcién de morphing se
puede reutilizar en distintos proyectos.

Efecto de pasar por diversos niveles de dibujos para crear una sensacién de
profundidad en un plano. Un multiplano es una escena en la que las capas estén
colocadas a distintas distancias de la cdmara, de modo que, cuando la cdmara se
mueve, se produce una ilusién de profundidad. Con un multiplano, toda la
perspectiva y la escala se calculan automdaticamente.

Sistema de difusién televisiva analdgico estdndar utilizado antiguamente en
Norteamérica.

Resolucién que funciona mejor con el formato europeo para pantallas de
televisidn y de ordenador, ya que los pixeles rectangulares se muestran con una
orientacion distinta.

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante
toda la produccidn para mantener la coherencia en el aspecto y para garantizar
que se utilicen los mismos colores durante la produccién. Conocida también como
paleta.

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o
prop. La paleta se utiliza durante todo el proyecto para mantener la coherencia
en el aspecto y para evitar cambios de color durante la animacién. También se le
denomina paleta maestra.
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panear Mover la cdmara atravesando la escena en cualquier direccidn.

panel En un storyboard, un panel es un fotograma en un plano. Un plano puede estar
compuesto por uno o varios paneles.

papel cebolla Funcién que permite ver los dibujos anterior y siguiente de una secuencia.
paso con doble En los fotogramas clave y las posiciones de paso de un paso con doble bote, el
bote cuerpo es menor que una linea de referencia dibujada en posicién vertical.

Durante los intercalados, el cuerpo estd situado sobre esta linea, ofreciendo asi un
aspecto de rebote.

peg En la animacidn tradicional, es una herramienta utilizada para garantizar el
registro preciso de la accién a medida que se mueven las capas de celdas. En la
animacion digital, en la que se realiza un rigging de marionetas mds avanzado, se
pueden usar capas de pegs. Las capas de pegs son capas de trayectoria que no
contienen dibujos. Son rutas de movimiento que puede usar para agregar
articulaciones de ruta. Para las Ultimas, también puede utilizar una herramienta
de cinematica inversa.

pivote Punto alrededor del cual un peg o dibujo rota.

pixel Elemento mas pequeio de una imagen mostrado en un monitor o pantalla de
televisidn. El pixel, abreviatura en inglés de elemento de imagen, es un punto
Unico en una imagen grafica. Es una pequefia muestra de una imagen, un punto,
un cuadrado o una seccién muy pequefia compuesta de filtrado suavizado. Si
acerca el zoom lo suficiente en una imagen digital, verd los pixeles, que parecen
pequenos cuadrados de distintos colores e intensidad.

planificacién de Dibujo de las funciones principales de la escena que se utiliza como referencia al
layout planificar la animacidn y ejecutar sus etapas iniciales.
plano Escena en una pelicula o programa. Una secuencia estd compuesta por varios

planos. Un plano cambia a otro mediante un corte simple o por transicién.

plano de Escena en la cual el espectador puede ver toda el drea en la que se estd

situacion produciendo una secuencia. Por ejemplo, si un nifio estd jugando en el patio
delantero de su casa, el plano de situacidn seria una escena en la que el
espectador puede ver la casa, el patio, parte de la calle y los edificios situados
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plantilla

pose clave

posicién de
paso

proceso de
layout

proporcién

renderizado

resolucién

RGB

alrededor del punto de accién central. Esto ayuda al espectador a entender la
ubicacidn de la historia y la orientacidn de la escena.

Recurso almacenado en la librerfa que se puede reutilizar en cualquier proyecto.
Una plantilla puede ser un dibujo, una serie de fotogramas clave, un archivo de
sonido, un panel, un personaje Cut-out, un efecto, una trayectoria, una animacion
o cualquier otra cosa que se utilice en la animacidn.

Posiciones importantes en la accién que definen los puntos inicial y final de
cualquier transicién suave. Las claves, o poses clave, son los dibujos principales de
una secuencia de animacién que describen el movimiento. Por ejemplo, si se agita
un brazo, las claves corresponderdn al brazo de una extremidad del movimiento
de onday a la otra extremidad. Al realizar un flipping de dichos dibujos, el
animador puede ver el esqueleto del movimiento sin tener todos los dibujos.

Al dibujar una secuencia en la que un personaje camina, la posicién de paso es el
punto en el que una pierna pasa a la otra.

Paso de comunicacidn entre el storyboard y la animacién.

Proporcién entre las dimensiones de ancho y altura de una escena, fotograma o
formato de pelicula. Actualmente, la proporcién mas popular es 16:9. Las
pantallas antiguas utilizaban una proporcién de 4:3.

Paso final de la animacidn por ordenador. Durante el renderizado, el ordenador
toma cada pixel que aparece en la pantalla y procesa todos los componentes.
Ademds, agrega desenfoque de movimiento antes de que produzca una imagen
final. Es el proceso de calcular las imagenes finales después del proceso de
composicion.

Tamanfo de una escena, calculado por lo general en pixeles. Por ejemplo, |a
resolucion NTSC es de 720 x 480. La resolucién debe coincidir con la salida final:
HDTV, film-1.33, film-1.66, NTSC, PAL, baja.

Siglas en inglés para rojo, verde y azul. Método que permite definir el color
especificando las cantidades de estos tres componentes del color.
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rigging

rotoscopia

secuencia

simbolo

sincronizacién
de labios

slugging

storyboard

tableta/ldpiz

transicion

trayectoria

Proceso de conectar las distintas partes de una marioneta Cut-out.

Técnica de animacidn en la que los animadores trazan un movimiento de pelicula
de accidn en vivo, fotograma a fotograma, para usarlo en peliculas animadas. Es el
acto de esbozar sobre material de accién en vivo para crear una secuencia
animada.

Serie de escenas o planos que forman una parte distinta de la historia o pelicula,
normalmente conectadas por la unién de la ubicacidn o el tiempo.

Un icono combina animacidn, ilustracién o capas en un Unico objeto que puede
controlar en una capa. También puede crear iconos de cada parte del cuerpo en
marionetas Cut-out. En un icono puede colocar lo que desee. Puede utilizar
simbolos para animar una marioneta o crear animaciones reutilizables, como un
parpadeo.

Proceso que consiste en sincronizar la boca de un personaje con sonidos en la
pista de sonido del didlogo. La boca se ajusta fotograma a fotograma para hacer
coincidir el sonido del didlogo y aparentar que el personaje estd hablando. La
sincronizacién de labios se puede utilizar para cualquier secuencia de sonidoy no
solo para el habla. Por ejemplo, puede hacer que un pdjaro pie o que un lobo allle
alaluna.

Indicacidn de los tiempos de inicio y detencién de un didlogo y las acciones
relevantes.

Plan visual de todas las escenas y planos de una animacion. El storyboard indica
lo que sucederd, cuando lo hard y cdmo se distribuyen los objetos en una escena.

Dispositivo utilizado junto con un ratdn, o en lugar del mismo, para mover el
puntero (en ocasiones denominado cursor) por la pantalla del ordenador.

Efecto colocado entre dos escenas cuando se pasa de una a otra. Los efectos de
transicion comunes son el fundido encadenado vy el barrido.

Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La
trayectoria se puede controlar mediante puntos de control, fotogramas clave y
velocidad.
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vector

velocidad

vibracién de
camara

Zona

ZOoha segura

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una
prueba de linea o de lapiz final, cada dibujo se traza y se pinta para la animacidn
final. En el mundo digital actual, esto se puede realizar de maneras distintas a los
métodos de celuloide o acetato tradicionales.

Asignar un dibujo determinado a un rango de fotogramas.

Unaimagen basada en vectores estd compuesta por puntos y curvas Bézier. El
ordenador lee los puntos y traza los segmentos, vinculdndolos para reproducir la
forma de imagen. Una imagen vectorial no contiene tamafio fijo ni resolucién. El
grafico se puede ampliar y distorsionar segun se desee y el sistema volverd a
calcular los segmentos y reconstruira las formas. Las imdgenes vectoriales se
trasladan y se muestran en pixeles una vez que el célculo se ha realizado.

En animacidn, la velocidad es la aceleracion o la desaceleracién de un movimiento.
Se puede alcanzar mediante una curva de funcién o una serie de dibujos
animados. Otros términos comunes para aceleracidon gradual y desaceleracion
gradual son aceleracién y desaceleracion.

La vibracién de cdmara se produce en una escena cuando la cdmara se mueve
ligeramente y rapidamente en varias direcciones. Este movimiento da la
impresién de impacto, vibracién o, por ejemplo, baches en la carretera.

Area que se puede pintar con color.

Zona central del fotograma de una escena que no quedara recortada por el
fotograma de TV. Como un fotograma de TV corta un margen del tamano del
fotograma original, al mantener una zona segura se garantiza que la accién
principal de la escena siga siendo claramente visible una vez que la pelicula se
proyecte en television.
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